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Software License Agreement
This AccuSoft software product ("Product") is a proprietary and copyrighted Product of Schellenbach & 
Associates, Inc. dba AccuSoft Enterprises ("ASE"). It is licensed (not sold) to you, and you may use this 
Product only on the terms of this license from ASE, even though you may have obtained the Product from 
a dealer or other source.

License
ASE grants you a non-exclusive license only to:

1. If you have purchased a Single User License as indicated by the Product media label, you may use 
the Product on one computer or thin-client terminal which you own or use. A Separate license is 
required for use on each other computer or thin-client terminal on which the is Product used. But, 
you may transfer the product to another computer if it is a replacement for the original computer or if 
the original computer is inoperable due to a malfunction, until it is repaired.

2. If you have purchased a Small Business License, you may use the Product on a limited number of 
computers or thin-client terminals which your Company owns or uses (seats). The number of seats 
you are authorized to use the product on is 50, unless otherwise designated on the Product media 
label. Additional seats are available for additional cost. However, the seat limit will not apply if every
computer or thin-client terminal on which the Product is used is located in a single building, 
facility, or campus. 

You may make copies of this Product as necessary to use the Product with other Computers owned 
or used by your Company as long as the seat limit is not exceeded. 

A separate license is required for use by any affiliate of your Company. 

3. merge the Product with other applications which utilize the Product. This license will remain effective 
as to any merged portion of this Product. 

4. make one copy of the Product for archival or backup purposes in support of your use of the Product. 

5. transfer the Product and this license to another party if the other party agrees to accept the terms 
and conditions of this Agreement. If you transfer the Product, you must at the same time either 
transfer or destroy all copies, including any portions of the product merged into other programs or 
stored on computer memory devices such as hard disks. IF YOU TRANSFER POSSESSION OF 
ANY COPY OR MERGED PORTION OF THE PRODUCT TO ANOTHER PARTY WITHOUT 
TRANSFERRING THE PRODUCT ITSELF AS PROVIDED HERE, YOUR LICENSE IS 
AUTOMATICALLY TERMINATED. 

Except as otherwise provided in this agreement, you have no right under this license to rent, lease, 
transfer, or distribute the Product. You may use the Product in object code form only.

Title
Title and copyright to the Product, including the Product media and documentation, remain with ASE. You 
are not the owner of this Product, but you have the right to use it in accordance with this license. You are 
not licensed to copy, reproduce or make data transmissions, in whole or in part, of the Product, except as 
is permitted in this license. You agree not to modify, reverse engineer, translate, disassemble or 
decompile the Product, in whole or in part.

License Term
The license is effective upon opening of the Product package or use of the Product and shall continue until 
terminated. You may terminate it at any time by destroying the Product together with all copies and the 
Product Documentation. THIS LICENSE WILL TERMINATE AUTOMATICALLY IF YOU FAIL TO COMPLY 
WITH ANY TERM OR CONDITION OF THIS LICENSE. Upon termination you agree to destroy the 
Product, the Product Documentation and all copies, purge the Product from all computers and memory 
devices such as hard disks, and eliminate the Product from any merged programs.

Limited Warranty
ASE warrants that for a period of six (6) months from date of purchase the Product will perform according 
to the specifications set forth in the associated Product Documentation and the diskette (or other medium) 
on which the Product is located will be free from defects in materials and workmanship under normal use.

YOU ASSUME THE RESPONSIBILITY FOR THE SELECTION OF THE PRODUCT TO ACHIEVE YOUR 
INTENDED RESULTS, AND FOR THE INSTALLATION, USE AND RESULTS OBTAINED FROM THE 



PRODUCT. ASE does not warrant that the functions contained in the Product will meet your requirements 
or that the operations of the Product will be uninterrupted or error free, or will function properly in every 
hardware environment. This warranty gives you specific legal rights and you may also have other rights 
which vary from state to state.

EXCEPT AS EXPRESSED HEREIN, THE LICENSED PROGRAM IS PROVIDED TO YOU "AS IS". ASE 
DISCLAIMS TO THE FULLEST EXTENT PERMITTED BY LAW ALL OTHER WARRANTIES, EXPRESS 
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WHICH SHALL IN NO EVENT 
EXCEED ONE YEAR. Some states do not allow the exclusion of implied warranties so the above 
exclusion may not apply to you.

No person is authorized to modify the warranties contained in this license or make any different warranty 
for the Product.

Limitations of Remedies
ASE's entire liability and your exclusive remedy shall be limited to:

1. the replacement of any Product, including its diskette or other medium, that does not meet the 
standards of the limited warranty above. To use this warranty, you must return, at your expense, the 
Product and all copies along with a copy of your purchase invoice and a brief description of the 
defect to AccuSoft Enterprises, Customer Service Dept., 8041 Foothill Blvd., Sunland, CA 91040. 
Upon verification of the defect, ASE will send to you, at ASE's expense, a replacement Product. 

2. if ASE is unable to deliver a replacement which is free of defects, ASE will refund your purchase 
price.

IN NO EVENT WILL ASE BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, 
LOST SAVINGS, LOST DATA OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING 
OUT OF THE USE OR INABILITY TO USE THE PRODUCT EVEN IF ASE OR ANY OF ITS DEALERS 
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY 
OTHER PARTY. ASE'S MAXIMUM LIABILITY SHALL IN NO EVENT EXCEED THE PURCHASE PRICE 
YOU PAID FOR THE PRODUCT. Some states do not allow the limitation or exclusion of liability for 
incidental or consequential damages so the above limitation or exclusion may not apply to you.

Customer Registration
ASE may from time to time revise and update its Product or provide useful customer information. You may 
wish to know about Product improvements and the availability of upgrades. To obtain this useful service, 
you must fill out and return the enclosed customer registration card. ASE urges you to do so immediately.

General
You may not sublicense, assign or transfer this license or the Product to any other person or entity except 
as expressly allowed in this license. Any attempt to sublicense, assign or transfer is void.

This Agreement will be governed by laws of the State of California, exclusive of its choice of law 
provisions.

You further agree that this is the complete and exclusive statement of the agreement between us which 
supersedes any proposal or prior agreement, oral or written, and any other communications between us 
relating to the subject matter of this agreement.

If any provision of this agreement shall be held to be invalid, illegal or unenforceable, the remaining 
provisions shall not be affected.

If you have any questions concerning this license, you should contact AccuSoft Enterprises,  Customer 
Service Dept., 8041 Foothill Blvd., Sunland, CA 91040, USA.



Contents

Introduction
Features of AccuTerm 2K2 ................................1
Hardware and Software Requirements ...............3

Getting Started...........................................................5
Installation..........................................................5
Network Installation ...........................................7
Activating an evaluation version ........................7
Running AccuTerm 2K2.....................................8
AccuTerm Main Menu .....................................10
Keyboard commands ........................................17

Configuring AccuTerm............................................19
General Settings................................................20
Connection Settings..........................................23
Terminal Type Settings.....................................39
Screen Settings .................................................43
Font Settings.....................................................47
Color Settings ...................................................49
Keyboard Settings.............................................53
Printer Settings .................................................57
File Transfer Settings........................................60
Miscellaneous Settings .....................................63

Auto Dialer ..............................................................65
File Transfer ............................................................67

Installing the MultiValue Host Programs.........68
File Transfer Wizard.........................................72
Command-Line File Transfer Utilities..............74
Standard (non-MultiValue) File Transfer .........94

Data Capture............................................................99
Macro Recorder.....................................................101
wED Editor............................................................103
Appendix A – ASCII Codes ..................................109





Introduction 1

INTRODUCTION

Welcome to AccuTerm 2K2 – MultiValue Edition.  We’ve worked hard 
to give you the fastest and most accurate terminal emulation package on the 
market.  We have also tried to make it easy to use.  Our philosophy has been 
to add the features that will be most useful without sacrificing ease of use, 
accuracy or performance.

This User Guide is intended to help you install, configure and use 
AccuTerm 2K2. A separate Programmers Guide is available, and it includes 
information on programming AccuTerm, control codes, escape sequences, 
scripting, ActiveX/OLE features, the GUI development environment and 
Windows/host integration.

Features of AccuTerm 2K2

Multiple sessions using MDI (Multiple Document Interface). This means 
that you can run two or more terminal sessions at the same time without 
running two copies of AccuTerm. It works the same as other programs that 
allow you to work with more than one document at a time like word 
processors, spreadsheets, etc. so it’s easy to work with. You don’t have to 
learn a new way of working.  Also, by using MDI instead of running 
multiple copies of AccuTerm, you use less system resources and memory.  
You can still run multiple copies if you choose, we just think MDI works 
better.

User interface has Office 2000 look and feel, including context menus 
accessed by clicking with the right mouse button. The new toolbar can be 
hidden completely and also features balloon help that shows you what the 
buttons mean. Toolbar, menu, session bar and status bar can be customized 
by the user.

Full OLE Automation / ActiveX support allows integration with other 
Windows applications. AccuTerm 2K2 acts as both automation client and 
automation server. AccuTerm exposes its application and session objects, 
which allows other applications complete control of AccuTerm.
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ActiveX component (OCX) terminal emulation & communications engine 
may be used in custom VB applications where accurate terminal emulation 
is required.

Secure Shell connections ensure privacy using public key encryption 
technology.  SSH1 and SSH2 protocols are supported, and several ciphers 
are available.

Accurate emulations. When you use AccuTerm everything will work just 
like the terminal being emulated.  No strange problems with word 
processors or spreadsheets.  No messed up screens.  No hassles.

Modem connections use Windows built-in dialer, and unlimited phone 
directory entries.

Fast File Transfer capabilities using industry standard protocols like 
Xmodem, Ymodem, Zmodem, and Kermit. MultiValue file transfer wizard 
and utilities import and export MultiValue data in a variety of formats. And 
direct Host-to-Host file transfer, too!

Scripting language and macro recorder allows users to record macros or 
write scripts using Visual Basic for Applications (VBA).

Enhanced scroll back window saves up to 10,000 lines for instant recall.

Extended screen support of up to 240 columns by 240 rows.

Automatic font scaling so that you can always see the full screen.  This is a 
great feature. Once you get used to it, you’ll never want to go without it!

Enhanced network support for Telnet , Secure Shell (SSH1 & SSH2) and 
PicLan.

GUI Development Environment helps you build user-friendly GUI front-
ends for your MultiValue applications.

Tabbed setup screens efficiently organize settings and preferences.

Image and sound support lets you to display images anywhere on the 
terminal screen.  You can also play Wave and MIDI sound files.

wED Windows based program / data editor includes BASIC syntax 
highlighting in an MDI environment.



Introduction 3

Tektronix graphics terminal emulation in both color and monochrome.

Visual Styles and full color mapping lets you choose any foreground and 
background color combination for any terminal visual attribute, and attach a 
border effect to the attribute.  Application of Visual Styles can give 
character-based applications an instant face-lift!

Easy to use. AccuTerm follows the Windows Interface Application Design 
Guide more closely than many other terminal emulation programs.  This 
makes AccuTerm easier to learn and use.

Hardware and Software Requirements

Memory: 128MB

Processor: Pentium3-500 or better

Windows: 95, 98, ME, NT 4.0, 2000, XP, 2003, Vista

COM port: Any serial port, modem or network adaptor supported by 
Windows

Mouse: Any mouse supported by Windows

Note: in order to open a Secure Shell connection, you must have 128 bit 
encryption installed in Windows.  To check Windows encryption, open 
Internet Explorer and select “About Internet Explorer” from the Help menu. 
If the Cipher Strength is less than 128 bits you will need to either upgrade to 
Internet Explorer 6.0 (or above) or install the High EncryptionPack for your 
version of Internet Explorer. Search Microsoft’s web site for “High 
Encryption” for more information. In order to use the AES cipher with 
Secure Shell, you need to be running Windows XP or higher.
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GETTING STARTED

This manual assumes that you have a working knowledge of the Windows 
environment.  If you are new to Windows, there are many good books 
available.  They do a much better job of explaining the basics than we could 
do in this manual.

Installation

To install AccuTerm 2K2, insert the AccuTerm 2K2 program CD and click 
the “Install AccuTerm 2K2 Standard Edition” button when the startup 
screen is displayed. If the startup screen does not display, select “Run” from 
the Start Menu, and enter “D:\Autorun.exe” in the “Open” text box, then 
click OK (change D: to the letter for your CD drive).

1) The AccuTerm 2K2 installation wizard will guide through the 
installation process. You will be prompted to enter your 
authorization key, registration information, select the 
destination directory and select a start menu program folder. 
You move forward through the installation process by clicking 
the Next button. You can click the Back button to move back, 
or the Cancel button to cancel the installation.

2) The first item you need to enter is your Authorization Key. 
Enter each half of the key into a separate box. Click Continue
after you have entered your key. Do not enter anything in the 
Custom code box unless your dealer has given you a custom 
code. After clicking on the Continue button, the software 
license agreement will be displayed. You can scroll through 
text of the license and if you accept the license terms, click the 
OK button.

3) The Welcome dialog is displayed. Click the Next button.
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4) The Registration Information dialog box is displayed.  Please 
enter the user, company and location in this dialog, then click 
the Next button.  Depending on your software license, some 
fields may not be displayed.

5) Select the directory where you want the AccuTerm program 
files to be installed, then click the Next button. The default 
installation directory is C:\Program Files\Atwin.

6) Select a “home” directory. The default “home” directory is the 
current user’s “My Documents” directory. This is the directory 
where AccuTerm will start from when using Open andSave 
for reading and writing session configuration files. After 
selecting the “home” directory, click the Next button.

7) Choose whether you want files which are replaced during 
installation to be saved in a backup directory. If you select this 
option, when you click the Next button, you can select the 
directory where replaced files are saved.

8) Select a “Start Menu” folder for the AccuTerm 2K2 shortcut. 
If you would like a shortcut to AccuTerm 2K2 placed on your 
desktop, select the “Place shortcut on desktop” option. If you 
want the shortcut to be available to all users of the PC, select 
the “Make shortcut available to all users” option. Click the 
Next button.

9) To begin installing files, click the Next button. The installation 
progress will be displayed.

10) Some features of AccuTerm 2K2 utilize the Microsoft Data 
Access Objects (mainly importing and exporting data to and 
from Microsoft Access databases). If you do not already have 
version 3.5 (or higher) of the Microsoft Data Access Objects 
installed on your computer, you can select to have these 
components install at this time.  A system reboot will be 
required during this installation.

11) When the installation is complete, you can view the release 
notes by checking the “View release notes” box, and clicking 
Finish. If you do not want to view the release notes at this 
time, simply clear the “View release notes” box and click 
Finish.
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During installation, you may get a message indicating that the OLE or 
system files are in use and need to be updated.  If this occurs, please shut 
down all other applications, then click the OK button to restart Windows. 
After Windows restarts, the installation process will resume (if it does not 
resume automatically, simply start the installation over again; this time the 
OLE or System files should have already been updated and you will not get 
this message again.)

Network Installation

If you have a network and are installing a Small Business License or 
Enterprise License version of AccuTerm, you can copy the “Atwin2K2” 
folder from your installation CD to a network share. You can then install 
AccuTerm on any workstation that has access to the network share by 
navigating to the shared Atwin2K2 folder and double-clicking on the 
atw2k253a.exe file name.

Even if you are installing AccuTerm from a network, you still must install it 
on each workstation. This is because some files are installed in non-shared 
directories such as WINDOWS and WINDOWS\SYSTEM.

Some aspects of the installation process can be customized. Please see the 
“Custom Features” topic in the AccuTerm Programmers Guide for more 
details.

Activating an evaluation version

To activate an evaluation version of AccuTerm 2K2 after obtaining an 
authorization key (or CD key), you need to re-install the program. You do 
not need to un-install the program first. Simply re-install, and enter the key 
when prompted.



8 Getting Started

Personal Edition limitations

AccuTerm 2K2 Personal Edition is a free, non-commercial, version of 
AccuTerm 2K2 for educational purposes. It includes all standard AccuTerm 
2K2 features except that connections are restricted to “localhost” 
(127.0.0.1) only. Also, a local version of a supported MultiValue database 
must be running on the same system. For a current list of supported 
platforms, click on the Personal Edition link from the Products page on 
www.asent.com.

Running AccuTerm 2K2

AccuTerm 2K2 uses the Windows MDI (Multiple Document Interface) 
standard for handling more than one session.  It works the same as other 
popular Windows applications like Microsoft Excel and Microsoft Access, 
except that instead of opening workbooks or tables, you open terminal 
session configuration files.  Each configuration file that you open becomes 
one session. Normally, terminal session configuration files are saved with 
the .atcf extension.

To run AccuTerm 2K2, simply select from the Start 
menu, or click the AccuTerm icon on the desktop. AccuTerm’s main 
window will be displayed.  At the start, AccuTerm shows a blank 
workspace, menu and toolbar. Any terminal sessions you create or open 
are displayed in the workspace. Most menu and toolbar functions are 
disabled at this time because no terminal sessions are open yet.

The first time you run AccuTerm 2K2 you will be prompted to create a 
new terminal session using the Connection Wizard. To create a session, 
click the Yes button at this time. You can always create a session at later 
time by choosing New from the File menu.

Creating a New Session 
After starting AccuTerm, you can use the Connection Wizard to guide you 
through the process of creating a new session. To start theConnection 
Wizard, select New from the File menu or click the button on the 
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toolbar.  When the New Connection dialog is displayed, click the 
Connection Wizard button to start the wizard, then follow the step by step 
instructions for creating a new session. If you prefer to configure the 
terminal settings manually, click the Custom Settings button instead.

When a session has been opened, it occupies some (or all) of the workspace. 
Several sessions may be open at the same time, and they share the 
workspace. The session windows can be cascaded or tiled, or may occupy 
the entire workspace.

Shortcuts
You can also create a shortcut to any session configuration file (or layout 
file) by dragging the file from Windows Explorer and dropping it on the 
desktop while holding the CTRL + SHIFT keys. When you double-click the 
shortcut to an AccuTerm session or layout file, AccuTerm will automatically 
load that file when it starts.

Note: to load a layout and run a script, open the layout file, load the script, 
then save the layout. Create a shortcut to the layout file name as described 
above. When opening the layout file, first all session files contained in the 
layout will be opened, then the script’s Main subroutine will be run.
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AccuTerm Main Menu

File Menu
The AccuTerm File menu contains options for creating, opening, closing 
and saving a sessions, and printer setup and control. Common menu options 
may also be executed by clicking a button on the toolbar.

File New
To create a new terminal session, select the New option or click the 

button on the toolbar. The New Connection dialog will be 
displayed. Select Connection Wizard to use the connection wizard 
to help you build a new session, or select Custom Settings to 
create a new session and enter the settings yourself.

File Open…
To open an existing session configuration file, select the Open
option or click the button on the toolbar.  This creates a new 
session with the settings saved in the selected configuration file.

File Close
To close the active session, select the Close option.  If you have 
made any changes to the session settings, you will have the 
opportunity to save them in a session configuration file before 
closing the session.

File Save and File Save As…
After adjusting session settings, save the new settings in a 
configuration file by selecting the Save or Save As option, or by 
clicking the button. 

File Save Layout and File Save Layout As
If you have several sessions open, you can save them as a group, or 
layout, by selecting the Save Layout or Save Layout As options.

File Printer On
Selecting this option toggles the slave printer  on and off.  When 
the slave printer is on, received data is printed on the selected 
printer and displayed on the terminal screen.  You can also press 
ALT + P to toggle the slave printer state.
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File Print Screen
Selecting this menu option or clicking the button causes the 
current terminal screen to be printed on the selected printer.  You 
can also press ALT + G to print the terminal screen.

File Print Setup…
Select this option to set up printer information.  See the section on 
“Printer Selection” in the next chapter for details.

Recent files
Opens one of the most recently opened terminal session 
configuration or layout files. By default, the last four files are 
shown. The number of files to show is customizable (see “General 
Settings” in the next chapter).

File Exit
Select this option to terminate AccuTerm 2K2.

Edit Menu
The AccuTerm Edit menu contains commands to copy and paste from the 
Windows clipboard and select the screen.

Edit Copy
This command will copy a selected block of text from the terminal 
screen to the Windows clipboard.  If there is no selection, the entire 
screen is copied.  To select a block on the screen, position the 
mouse on the upper left corner of the desired block.  Press and hold 
the left mouse button for about one half second, then drag the 
mouse to the lower right corner, and release the button.  The 
selected area will be indicated by a dotted rectangle.  To remove 
the selection, click the left mouse button anywhere on the screen.  
If the screen needs to be scrolled to select the desired data, move 
the mouse to the edge of the window and the window will 
automatically scroll in that direction.  You can also click the 
button to copy the screen or selection to the clipboard.

Edit Paste
This command will send the clipboard contents to the host 
computer.  Each line is terminated as specified in the ASCII file 
transfer settings (see Miscellaneous Settings). Clicking the 
button will also perform this function.
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Edit Paste From…
This command will send the contents of a text file to the host 
computer.  A file selection dialog box will be opened when you 
select this command.

Edit Select Screen
This command will select the entire screen. You will see a dotted 
rectangle around the selection.

Edit Select All
This command will select the entire screen and history. You will 
see a dotted rectangle around the selection.

Edit Select None
This command will remove any selection and erase thedotted 
rectangle.

View Menu
The AccuTerm View menu contains options to select screen size, display or 
hide the toolbar, status bar and session bar.

View Extended Screen Size
Toggles the screen size between Normal (usually 80 columns by 24 
rows) or Extended (usually 132 columns by 24 rows) size. See 
“Screen Settings” for information on setting the number of columns 
and rows. The screen size may also be changed by clicking the 

button.

View Toolbar
Check this option if you want the toolbar displayed in AccuTerm’s 
main window.  Un-check this option if you want the toolbar hidden.

View Status Bar
The status bar displays information about the current session: 
keyboard state, cursor position, screen size, terminal type, printer 
status, capture status, connection type and connection status. Check 
this option to display the status bar at the bottom of AccuTerm’s 
main window.  Un-check this option if you do not want the status 
bar displayed.
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View Session Bar
The session QuickBar is used to quickly navigate between multiple 
sessions. It is similar to the Windows taskbar. Every session has a 
button on this bar and clicking on the button activates that session. 
Check this option if you want the session bar displayed at the 
bottom of AccuTerm’s main window.  Un-check this option if you 
do not want the session bar displayed.

View Function Bar
The function bar is used to display a row of function key buttons at 
the top or bottom of the session window. These buttons perform the 
same action as the twelve function keys on the keyboard. The first 
button in the bar is the bank selector. Click this button to select the 
active function key bank from a small popup menu: normal, shift, 
ctrl or shift+ctrl. The default function key button captions are 
simply F1 ... F12, however, the captions may be customized in the 
Keyboard tab of the Settings dialog.  The General tab of the 
Settings dialog provides options to select the bar position (top or 
bottom) and display the key number in the corner of each button. 
Un-check this option if you do not want the function bar displayed.

Tools Menu
The Tools menu contains options for modifying AccuTerm’s settings, 
dialing a number, initiating file transfers and data capture, recording a 
macro and opening the script window. Each of these options opens a dialog 
box where the desired function is performed. See the appropriate section in 
this manual for details on each function.

Tools Settings…
Select this option or click the button to open the Settings 
dialog box. This dialog is used to modify all of AccuTerm’s 
settings and preferences, such as communications device, terminal 
type, screen colors, etc.

Tools Customize Menu…
Select this option to open the AccuTerm Menu Designer, which is 
used to customize the menu, toolbar, status bar and session bar.  
For information on customizing the menu and toolbar, see the 
“Customizing the Menu and Toolbar” chapter in the AccuTerm 
Programmers Guide.
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Tools Dialer…
Select the Dialer option to enter or choose a phone number to dial 
when using a Modem connection. Also choose this option to 
disconnect a Modem connection. Note: this option will be disabled 
unless the connection type is “Modem”.  You can quickly call up 
the Dialer dialog by clicking the button on the toolbar.

Tools Upload
Selecting this option displays the File Upload panel. Select 
Upload Wizard if you are connected to a MultiValue host system 
and want to use the File Transfer Wizard to guide you through the 
upload process. Select Manual Upload to open the AccuTerm 
File Upload dialog box, where you can select files to upload, select 
a transfer protocol, initiate an upload and specify other options. 
You can quickly call up the File Upload dialog by clicking the 

button on the toolbar.

Tools Download
Selecting this option displays the File Download panel. Select 
Download Wizard if you are connected to a MultiValue host 
system and want to use the File Transfer Wizard to guide you 
through the download process. Select Manual Download to open 
the AccuTerm File Download dialog box, where you can select 
the destination download directory, select a transfer protocol, 
initiate a download and specify other options. You can quickly call 
up the File Download dialog by clicking the button on the 
toolbar.

Tools Capture…
Selecting this option displays the Begin Capture or End Capture
dialog box. Use the Begin Capture dialog to select the destination 
file and specify other options. Use the End Capture dialog to 
terminate the capture operation. You can quickly call up the 
Capture dialog by clicking the button on the toolbar.

Tools wED Editor…
AccuTerm 2K2 includes a Windows based text and program editor 
designed specifically for MultiValue users.  If you are connected to 
a MultiValue host, you can access the wED editor by selecting this 
menu option or clicking the button on the toolbar.
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Tools GUI Designer…
AccuTerm 2K2 includes a development tool to help programmers 
create GUI applications for MultiValue systems. If you are 
connected to a MultiValue host, you can access the GUI Designer
by selecting this menu option or clicking the button on the 
toolbar.

Tools MultiValue Options…
Selecting this menu item displays the AccuTerm MultiValue TCL 
Rules dialog box. Several of AccuTerm's MultiValue tools 
(Upload Wizard, Download Wizard, wED Editor and GUI 
Designer) require a special MultiValue server utility to function. 
The server utility is typically initiated from “TCL”, and settings in 
this dialog define how AccuTerm gains access to TCL.

Tools Macro Record New Macro
Select this menu item to begin recording a new macro. All menu 
and toolbar actions, including changing settings and preferences, 
are recorded in the macro. Also, keystrokes sent to the host and 
responses from the host are recorded in the macro. When a macro 
is being recorded, a small control window is shown in the lower-
right corner of the screen. Use the control window to end, pause or 
resume macro recording.

Tools Macro Run Macro
This menu item opens a sub-menu which contains a list of recorded 
macros. Select the macro you want to run from this sub-menu. 
Note: a shortcut key can be assigned to a recorded macro to 
simplify running the macro.

Tools Macro Edit Macros
This option opens the AccuTerm Script window with the Macro 
tab (2) selected. Use this window to examine or modify the VBA 
code for your recorded macros.

Tools Script…
This option opens the AccuTerm Script window with the Main 
script tab (1) selected. Use this window to create, modify, run and 
debug VBA scripts.
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Reset Menu
This menu has options to reset the terminal or the connection.

Reset Terminal
Resets the terminal (clears screen, restores default character set and 
emulation, etc.) You can quickly reset the terminal by clicking the 

button on the toolbar.

Reset Connection
Resets the connection. If the session has been disconnected, this 
command will attempt to reconnect. You can quickly reset the 
connection by clicking the button on the toolbar.

Window Menu
The Window menu contains options for re-arranging the open sessions 
within the main window, and for switching from one session to another.

Window Cascade
This option arranges all open session windows so that they overlap.  
The title bar of all session windows remains visible.

Window Tile Horizontally and Window Tile Vertically
These options arrange all open session windows so that no 
windows overlap.

Windows
The open sessions are shown at the end of the Window menu. You 
can switch to any session by clicking on its entry in this menu.

Help Menu
You can get context sensitive help at any time by pulling down the Help
menu and selecting the Index or Contents option or by clicking the 
button.  To display information about AccuTerm, including version, release, 
serial number and registered user, select the About AccuTerm option.
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Keyboard Commands

Next Session – CTRL + TAB
If you have multiple session windows open, press CTRL + TAB to 
activate the next session. The sessions are sequenced in the order 
they were last active. You can press TAB multiple times while 
continuing to hold the CTRL key to scan the session windows until 
you find the one you want to activate.

Print Screen - ALT + G
Prints the terminal screen on the currently selected printer.

Data Capture - ALT + C
This is a shortcut to open up the Begin Capture dialog box.

Toggle Slave Printer Mode - ALT + P
Toggle slave printer mode on and off.

Previous Page - CTRL + PGUP
Displays the previous terminal page.  To use this command, the 
session must be setup with more than one video page.

Next Page - CTRL + PGDN
Displays the next terminal page.

Pause / Resume - SCROLL LOCK
This command pauses or resumes the processing of received data 
by the terminal.  The keyboard “Scroll Lock” LED indicates the 
current status.

Scanning the History Buffer
Use CTRL + SHIFT + PGUP, CTRL + SHIFT + PGDN, CTRL + SHIFT

+ UP, CTRL + SHIFT + DOWN, CTRL + SHIFT + HOME, and CTRL + 
SHIFT + END to navigate the history buffer.

Besides using the keyboard to navigate the history buffer, you can 
also use the mouse wheel (if your mouse has a wheel). Just scroll 
the mouse wheel up or down to scroll the history.

Note: you must specify a number of history rows to enable history 
scanning. To specify the number of history rows to utilize, choose 
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Settings from the Tools menu, Click on the Screen tab. Enter the 
desired number of rows.
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CONFIGURING ACCUTERM

Before you can use AccuTerm, you must configure the program.  The 
configuration process is used to tailor AccuTerm to your specific 
environment: workstation, printers, network and host computer.  You can 
also choose certain preferences.  This chapter describes the configuration 
process.

To modify AccuTerm’s settings choose the Settings item from the Tools
menu or click the button on the toolbar.

The Settings dialog box is organized into ten categories, with each category 
on a separate index tab. Click on one of the index tabs to display the settings 
for that category. You can also press the number of the category while 
holding the ALT key (use ALT + 0 for 10 – Misc).

When you have completed your changes, simply press ENTER (or click the 
OK or Apply button) to save changes, or press ESC (or click the Cancel
button) to discard changes and close the Settings dialog box.



20 Configuring AccuTerm

General Settings

The General tab is used to specify settings that affect the AccuTerm 
application overall, rather than a specific session.

Default phone book
This field contains the file name to be used as the default phone bookfor the 
dialer.  If no directory is specified, the current directory is assumed.  All 
dial-up sessions share this phone book.

The phone book file is a tab delimited ASCII file, with one line per entry; 
name and phone number are the two fields.

TCP/IP hosts file
The TCP/IP hosts file is an information file used to supply a list of host 
names to choose from when configuring a telnet or ssh connection. It is not 
necessary to define this entry, but if you know that your system has a hosts 
file, you can specify it here.

Default upload/download directory
This field contains the default directory for uploading and downloading 
files. Each session has its own setting (File Transfer tab) for this directory 
which will override this field if it is present.

Default capture directory
This field contains the default directory for storing captured data. Each 
session has its own setting (File Transfer tab) for this directory which will 
override this field if it is present.

Session title format
Each session window has a “title”, shown in the window’s title bar. The title 
consists of the session file name (or optional title specified in the Screen
tab), and the session number (or ID). You can customize how the title and 
ID are displayed in the window title bar by choosing an alternate title 
format. Options include displaying the ID after (default) or before the title, 
and enclosing the ID in parentheses ( ) or brackets [ ].
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Recent file size size
Specify the number of files to be shown at the end of the File menu for 
quickly opening your most frequently used sessions. Normally, the last four 
files are shown.

Single instance of AccuTerm
If this option is checked, only one instance of the AccuTerm program is 
allowed to be running.  If you try to start AccuTerm from the Start menu or 
desktop shortcut, and an instance of AccuTerm is already running, the 
currently running program will be activated.  When this option is not 
checked, a new instance of the AccuTerm program will be started; that is 
you will have two or more AccuTerm applications running.

Close AccuTerm when all sessions closed
If this option is checked, when the last open session is closed, the AccuTerm 
program will automatically close.  This option isuseful for network users 
when opening a configuration or layout file from a shortcut so that when all 
network sessions have been disconnected, AccuTerm will close 
automatically, without user intervention.

Warn before disconnecting
If this option is checked, when you attempt to close a session which is 
currently connected to the host (modem, Telnet, SSH connections), you will 
receive a warning that the session is still connected.  You can choose to 
cancel the close operation if you wish.  When this option is not checked, you 
will not receive this warning and the connection will be closed immediately. 
This warning does not apply to serial port connections.

Show large buttons in toolbar
Check this option to use large buttons in the toolbar.  If this option is not 
checked, small buttons are used.

Remember CapsLock and ScrlLock state when activating
When this option is checked, AccuTerm remembers and restores the state of 
the CapsLock and ScrollLock keys when the program is activated.  Each 
session maintains its own independent state for these keys. This option is 
only available for Windows NT, 2000 and XP.

Function key bar: at top of screen
Check this option to show the function key bar at the top of the session 
window. If this option is not checked, the bar will be displayed at the bottom 
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of the window.  Note: you must check the Function bar item in the View
menu to show the function key bar.

Function key bar: show key numbers
Check this option to show tiny key numbers in the corner of each button in 
the function key bar.
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Connection Settings

Connection Method
The Connection Method is used to select what type of connection or 
communications device you use between your computer and the host 
system. You will always be able to select Serial Port as a connection type. 
Depending on the hardware and software you have installed in your 
computer, you may also be able to select Modem, Telnet, Secure Shell or 
PicLan.

After selecting or changing the connection type, other settings relating to the 
selected connection type are enabled. For example, if Serial Port is 
selected, various options for a serial port connection, such as the port 
number, baud rate, parity, etc. will be shown. The specific settings for each 
connection type will be described later in this section.

Duplex
There are three duplex options: Full, Half and Local. In Full duplex, all 
characters typed on your keyboard are sent to the host computer. They are 
not printed on the screen. The host usually sends (echoes) the same 
character back; this is what is displayed on the screen. This is by far the 
most common configuration. In Half duplex, the characters you type are 
sent to the host machine and displayed on the screen. If the host system is 
configured for Full duplex and you select Half duplex on your computer, 
you will see each character that you type two times! In Local mode, 
characters you type are displayed directly on the screen and are not sent to 
the host computer.

Strip Eighth Bit
Most connection types use eight bits to represent each character. When 
using eight bits, the computer can send up to 256 different character codes. 
Some terminal types have no way of handling characters above 127 (hex 
7F). In this case, you can check this box and the eighth bit of each byte will 
be automatically stripped from all received characters. If you need to use 
any international characters or special symbols from the PC character set, 
you will need to clear this box to access them (the Wyse 60 and VTxxx 
emulations have commands to access these characters when using only 7 
bits).
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Close session on disconnect
This option is most useful when using Telnet or Secure Shell connections.  
If this option is checked, then when the connection is terminated by the host 
computer, the session will automatically close.  This option may be used in 
conjunction with the general setting “Close AccuTerm when all sessions 
closed” option.

Display communication errors
This option determines if communications errors are displayed or ignored. 
When using a network connection (Telnet, Secure Shell, PicLan) it is best to 
enable this option. For Serial Port and Modem connections you may want to 
disable this option, since “UART Overrun” errors are common and usually 
do not indicate a real problem.  If you suspect you are encountering errors, 
for example, if columns do not line up on a formatted screen, try setting this 
option, then reset the terminal (select the Reset Connection option from the 
main menu).
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Connection Settings – Serial Port

Port
Select the serial port on your computer which is connected to your host 
system. If you select the wrong port, you may get an error such as 
“Communication Port Unavailable”, or your terminal session may act like it 
is not connected.

Note: although AccuTerm allows you to select from port number 1 to 127, 
most computers only have one or two ports installed. To use any port with 
AccuTerm, it must first be correctly installed with the correct device driver.

Baud Rate
The baud rate is the speed that the serial port communicates with the host 
computer. AccuTerm supports baud rates from 300 to 115,000 baud. This 
setting must match the setting of the host computer’s serial port to which 
your computer is connected.  Baud rates of 9600 or 19,200 are most 
common.

Data Bits
Data Bits refers to the number of bits the serial port sends to represent each 
character. The options are 7 or 8 bits (the default is 8 bits). This setting must 
match your host system’s serial port setting.

Stop Bits
This is the number of bits that the serial port uses to separate each character. 
The options are 1 or 2 stop bits (default is 1). This setting must match your 
host system’s serial port setting.

Parity
Parity is an error checking mechanism performed by the serial port. The 
options are: None, Odd, Even, Mark and Space. Parity is rarely used, so 
selecting None (this is the default) is usually correct. This setting must 
match your host system’s serial port setting.

Handshake
Computers can send information very quickly. However, there are situations 
where one computer can send data faster than the other computer can 
process it. In these cases, the computer on the receiving end needs to inform 
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the sending computer to suspend transmission until the slower computer is 
able to catch up. A technique called “handshaking” is used to accomplish 
this task.

AccuTerm supports three methods of handshaking. The first and most 
common is. Xon/Xoff (or software handshake). With this method, 
AccuTerm sends a special Xoff character (DC3) to the host system when it 
wants the host to stop sending characters. When the AccuTerm has caught 
up, it sends the Xon character (DC1). AccuTerm normally uses “inbound” 
Xon/Xoff handshake; that is, AccuTerm can control flow of data from the 
host, but the host cannot control the flow of data from AccuTerm. If you 
check the “bidirectional” option, then AccuTerm will use both “inbound” 
and “outbound” Xon/Xoff handshake allowing the host to control the flow 
of data from AccuTerm as well.

The second handshake method supported by AccuTerm is DTR/DSR. This 
method is referred to as hardware handshake because it physically changes 
the voltages on the serial port to indicate whether the receiving computer is 
ready. 

The third handshake method, RTS/CTS, is similar to DTR/DSR handshake, 
except it uses a different pair of signals (pins) on the serial port.

For DTR/DSR or RTS/CTS handshake to work, the cable which connects 
your computer and the host computer must connect the appropriate 
handshake signals at both ends. Physical cable wiring is beyond the scope of 
this manual.

This setting must match your host system’s serial port setting.
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Connection Settings - Modem

AccuTerm 2K2 supports dial-up connections using any modem you have 
installed on your computer. AccuTerm uses TAPI (a service built into 
Windows for supporting telephony) to communicate with your modem. By 
using TAPI, AccuTerm can share the modem with other TAPI enabled 
applications, like Windows fax applications.

Modem Name
To use a modem connection, select a modem from the Modem Name list.

Note: if you change the modem installed in your computer (or sometime just 
install an updated driver for your modem), the modem name savedin your 
terminal session configuration file may not match the new modem name. If 
this happens, open the Settings dialog and select the new modem name from 
the Modem Name list.

Auto Answer
If you want AccuTerm to answer incoming calls, enable this setting”, 
otherwise disable (default) this setting.

Override Port Settings
Normally, AccuTerm configures the modem based on settings that are set up 
in Control Panel (Phone and Modem Options). Selecting this option allows 
you to override those settings. When this option is checked, options for 
selecting the modem baud rate, data bits, stop bits, parity and handshake 
become available.

See the previous section (Connection Settings - Serial Port) for details 
about baud rate, data bits, stop bits, parity and handshake settings.

Note: most modern modems work best using RTS/CTS handshake.

Dialing Options
To modify the dialing properties for the selected modem, such as your 
current location, area code, dialing prefixes, etc., click the “Dialing 
Options” button.
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Connect Only at This Speed
If the “Override port settings” option is selected, the “Connect only at this 
speed” option will be available. Normally, the baud rate of the modem’s 
serial port is set to the speed selected in the baud rate setting. However, the 
baud rate used to communicate between your modem and the host 
computer’s modem is negotiated by the two modems, and may not be the 
same as the baud rate setting. By selecting the “Connect only at this speed” 
option, AccuTerm will attempt to lock the modem-to-modem baud rate at 
the same speed as the baud rate setting.

This option is useful if you are able to dial and connect to the host computer 
modem, but the characters you receive are unintelligible garbage. This 
usually indicates a mismatch in the baud rate, usually between the host 
computer and its modem.

Note: this option does not work with all modems.
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Connection Settings - Telnet

AccuTerm supports Telnet connections to host systems on a TCP/IP 
network.  Any Telnet server (host) on the network, including hosts on the 
Internet, can be accessed.

Host Name
A valid Telnet host name or IP address must be entered in this field.  If a 
HOSTS file is available, you can click on the down-arrow to display a list of 
available Telnet hosts.

Host Type
If your type of host you are connecting to is listed in the Host Type list, 
please select it, otherwise just use the default host type. By selecting a host 
type from this list, certain advanced options are set up to be compatible with 
the specified host type. To see the advanced options, click on the Advanced 
button.
Port
If the Port field is left blank, or set to “default”, AccuTerm will use TCP 
port 23 (the default for Telnet).  If a different port is used for Telnet on your 
desired host machine, enter that port number in this field.

Certain host systems, such as Raining Data D3, allow a host process number 
(PIB) to be mapped to a specific TCP port number. You can use the Port 
setting to specify the port number mapped to your process number. Consult 
with your system administrator for this setting.

Connect Timeout
When establishing a connection to a host computer, AccuTerm will wait for 
a specified time for a response from the selected host system. You can 
specify the number of seconds AccuTerm should wait.  If this field is left 
blank, or zero, the default timeout is 15 seconds. Note: this timeout only 
affects the time AccuTerm waits for a response from the host when opening 
a connection to the host.

Advanced Options
By clicking on the Advanced… button, you can modify various Telnet 
options. These options are generally set by selecting a Host Type, but may 
be modified if necessary.
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If you change any settings in the advanced Telnet options, the host type you 
have previously selected will be changed to “custom”.

Echo (advanced option)
Most systems require the host to echo characters received back from the 
client (terminal).  That is, when you press a key, a character is sent to the 
host, and the host sends that same character back to the terminal, at which 
time it is displayed on the screen.  If this behavior is desired, then select the 
echo option (default).  If the echo option is not selected, then the Duplex 
setting should be changed to “half” to enable local echo of typed characters.

Binary (advanced option)
Normally, Telnet operates in Text mode, with special rules for handling CR
and LF characters. When the Binary option is selected, Telnet sends CR and 
LF characters without any alteration. Some hosts do not function correctly in 
Binary mode.

Use alternate break signal (advanced option)
Normally, Telnet sends the Interrupt Process command when you press 
CTRL + BREAK key.  When this option is selected, Telnet sends the Telnet 
Break command instead.

Bypass option negotiation (advanced option)
When this option is selected, Telnet option negotiation, which normally 
occurs when establishing a connection, is skipped. Certain Telnet servers, 
like Raining Data D3, do not support Telnet option negotiation, and require 
this option.

Send keepalives (advanced option)
When this option is selected, AccuTerm will send a dummy “keepalive” 
message to the host periodically (about every 2 minutes). This dummy 
message is discarded by the host and is transparent to the terminal session. 
This feature may be useful when the host system (or network equipment 
such as a router) disconnects an idle connection.

Note: certain Telent servers, like Raining Data D3 running on Window NT 
or 2000, are not compatible with this option.

Disable outbound coalescing (advanced option)
Use this option to improve terminal response over the network, at the 
expense of increased network traffic.
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Use U2 device licensing (advanced option)
By selecting this option, multiple connections (sessions) to Enterprise 
versions of UniData and UniVerse consume only a single user license. 
When the Suppress LF option is checked, the response sent to the host by 
AccuTerm is not terminated by an LF (line feed) character. Contact your 
IBM U2 dealer for information regarding device licensing.
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Connection Settings – Secure Shell (ssh)

AccuTerm supports secure connections to host systems over a TCP/IP 
network using Secure Shell (ssh).  Any ssh server on the network, including 
hosts on the Internet, can be accessed. AccuTerm implements both version 1 
and version 2 of the Secure Shell protocol. Protocol selection is usually 
automatic and uses version 2 if it is supported by the host. Otherwise, it 
automatically falls back to version 1.

Secure Shell employs public key encryption technology to ensure that your 
connection to the host is secure, even over the Internet. When you set up a 
Secure Shell connection, all information, including your user ID, password 
and session data is encrypted before transmission over the network.

AccuTerm Secure Shell requires Windows 128 bit encryption. To verify that 
you have the 128 bit encryption installed, open Internet Explorer, and select 
About Internet Explorer from the Help menu. If Cipher Strength is 128-
bit, then you should be able to create a Secure Shell connection. If it is not, 
you may need to upgrade you version of Internet Explorer to version 6 or 
higher, or install the High Encryption Pack (search for “High Encryption” at 
www.microsoft.com).

Host Name
A valid SSH host name or IP address must be entered in this field.  If a 
HOSTS file is available, you can click on the down-arrow to display a list of 
available hosts.

Port
If the Port field is left blank, or set to “default”, AccuTerm will use TCP 
port 22 (the default for ssh).  If a different port is used for ssh on your 
desired host machine, enter that port number in this field.

Connect Timeout
When establishing a connection to a host computer, AccuTerm will wait for 
a specified time for a response from the selected host system. You can 
specify the number of seconds AccuTerm should wait.  If this field is left 
blank, or zero, the default timeout is 15 seconds.Note: this timeout only 
affects the time AccuTerm waits for a response from the host when opening 
a connection to the host.
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SSH Version
Select the version of the SSH protocol that will be used by the connection. 
When you select “auto”, AccuTerm will automatically select the highest 
version supported by the host. If you select SSH1 or SSH2, AccuTerm will 
only connect using the selected protocol. If the host does not support the 
selected protocol, the connection will fail and an error message will be 
displayed.

Authentication
Select the authentication method which will be use to validate the user with 
the host.  AccuTerm supports both password and public key authentication.

Key
If public key authentication has been selected, click the Select… button to 
open the Key Management dialog. Use the Key Management dialog to 
create new keys, load existing keys and import keys created on another 
system.

Advanced Options
By clicking on the Advanced… button, you can modify various Secure 
Shell options.

Break character (advanced option)
Specify the character used to indicate a Break in this field. The default is 3 
(CTRL + C) but you can enter any ASCII code in this field if your host 
requires a different break character.

Preferred Cipher (advanced option)
If you wish to select the cipher used to encrypt the SSH session, you can 
select it from this list. If “auto” is selected, the default cipher (triple DES) is 
used. Otherwise, you can choose triple DES, Blowfish, 128 bit AES or 256 
bit AES. Note: the AES cipher is only available when using the SSH2 
protocol, and requires Windows XP.

Must Use Preferred Cipher (advanced option)
When this option is set, the cipher selected above must be supported by the 
host. If the selected preferred cipher is not supported by the host, the 
connection will be terminated and an error message displayed. When this 
option is not set, if the preferred cipher is not supported by the host, a 
different, mutually supported, cipher (normally, triple DES) will be used.
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Send keepalives (advanced option)
When this option is selected, AccuTerm will send a dummy “keepalive” 
message to the host periodically (about every 2 minutes). This dummy 
message is usually discarded by the host and is transparent to the terminal 
session. This feature may be useful when the host system (or network 
equipment such as routers) disconnects an idle connection.

Disable outbound coalescing (advanced option)
Use this option to improve terminal response over the network, at the 
expense of increased network traffic.

U2 device licensing (advanced option)
By selecting this option, multiple connections (sessions) to Enterprise 
versions of UniData and UniVerse consume only a single user license. 
When the Suppress LF option is checked, the response sent to the host by 
AccuTerm is not terminated by an LF (line feed) character. Contact your 
IBM U2 dealer for information regarding device licensing. Note: at this 
time, AccuTerm does not support U2 device licensing for Windows versions 
of U2.
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Connection Settings – SSH Key Management

When configuring a Secure Shell connection, AccuTerm supports both 
password and public key authentication. When public key authentication is 
selected, click the Select… button to open the Key Management dialog. 

Use the Key Management dialog to create public/private keys for SSH, or to 
load or import private keys. AccuTerm supports RSApublic keys for both 
SSH 1 and 2, and DSA public keys for SSH 2. AccuTerm can import SSH 2 
private keys that were created by OpenSSH. The public key file format 
AccuTerm uses is also compatible with OpenSSH (www.openssh.org).

Creating a new key
Click the Create New Key button to create a new public/private key pair. 
After clicking the Create New Key button, select the key type (RSA or 
DSA), and key length. The default length of 1024 bits is recommended. 
Enter a descriptive comment describing the key being created, and enter a 
passphrase to protect your private key. Although the passphrase is optional, 
it is highly recommended since anyone that gains access to your private key 
file can impersonate your identity! Once the passphrase is confirmed, the 
icon to the right of the passphrase field changes from a red X to a green 
check-mark. 

Click the Generate New Key button to generate the new key pair. This 
process may take some time to complete. When key generation is finished, 
the “fingerprint” for the public key will be displayed.

Click the Save Key File button to save the newly created key file. By 
default, AccuTerm will save the key in its standard key folder. You can 
select a different location, such as a removable USB drive, if desired.

Once your key pair is created, you need to place the public key on the server 
which you want to connect to. You can save the puclic key to a file by 
clicking the Copy Public Key button with the to file option selected. Once 
saved, you could attach the key to an email message and send it to the 
server’s administrator (it is a public key, so security is not a major issue). 
You could also save the public key file to a removable drive or diskette and 
mail or take it to the server administrator.
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If the server uses OpenSSH (or compatible) files, and if you currently have 
access to the server via password authentication, you can set up public key 
authentication using the following steps:

1) Open an AccuTerm session and connect to the server. Log in using 
your password.

2) Open the AccuTerm Settings dialog to create your new key pair. 
Click the Connection tab. Change the setting for Authentication
from password to public key.

3) Click the Select… button to open the Key Management dialog.

4) Click the Create New Key button and follow the steps above for 
creating a new key.

5) Select the to clipboard option and click the Copy Public Key
button to copy the public key to the clipboard.

6) Click OK two times to dismiss the dialogs. Ignore the warning 
about changes not being effective.

7) From a Unix/Linux prompt, change to your ~/.ssh directory. Edit 
the authorized_keys2 file using your favorite text editor. Start a 
new line in the authorized_keys2 file.

8) From the AccuTerm Edit menu, choose Paste to paste the public 
key into the authorized_keys2 file.

9) Save the modified authorized_keys2 file.

10) Save the modified AccuTerm session file. Close AccuTerm. Open 
AccuTerm and choose the session file you just modified.

11) Enter your user ID.

12) If you entered a passphrase when you created your new key, you 
will prompted to enter the password. Enter the passphrase (case 
sensitive).

13) If the server accepts your key, you will be logged in.

Loading an existing key
If your private key was saved to a different folder or to a removable drive or 
diskette, you can click the Load Existing Key button to load that key. Enter 
the passphrase and click the Verify button to check the passphrase. If the 
passphrase is correct, the public key fingerprint will be displayed. Click OK
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to use this key (in its current location). Otherwise, you can save the key in a 
different location by clicking the Save Key File button.

Importing a key
Importing a key is exactly like loading an existing key, except for the file 
locations. AccuTerm can import private keys created using the OpenSSH 
file format.

Key fingerprint
When you create a new key, or load or import an existing key, AccuTerm 
displays the “fingerprint” of the public key. You can use this fingerprintto 
ensure that your key is correct. Use a utility on the server to show the 
fingerprint of the public key and compare to the fingerprint shown in 
AccuTerm.
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Connection Settings – PicLan

AccuTerm supports Modular Software's PicLan network for Pick hosts.  
Any PicLan enabled host (server) on the network can be accessed.

In order to use a PicLan connection, the PicLan client software must first be 
installed. Since PicLan utilizes the IPX network protocol, you must also 
install the IPX protocol in your network configuration.

AccuTerm supports up to ten PicLan connections allowing up to ten 
concurrent PicLan sessions.

Host Name
A PicLan host (server) name must be entered in this field.  Click on the 
down-arrow to display a list of available PicLan hosts (AccuTerm queries 
the network to assemble this list, it may take several seconds for this to 
occur).

Port
Enter the port (host process, PIB or port number) to be used to connect to 
the PicLan host.  This field may be left blank or may be set to “default” to 
indicate that any available port may be used. 

Connect Timeout
When establishing a connection to a host computer, AccuTerm will wait for 
a specified time for a response from the selected host system. You can 
specify the number of seconds AccuTerm should wait.  If this field is left 
blank, or zero, the default timeout is 15 seconds.



Configuring AccuTerm 39

Terminal Type Settings

AccuTerm emulates a variety of terminals.  In order to use AccuTerm with 
your host applications, you must select the correct terminal type for 
AccuTerm to emulate. The correct terminal type depends on the terminal 
type your host and/or application software requires. If you are unsure, you 
might type “TERM” at a MultiValue (D3, U2, jBase, etc.) command (TCL) 
prompt, or type “echo $TERM” at a Unix/Linux command prompt. The 
response may help you “guess” the correct terminal type.  If the application 
screens look correct, then you probably have the correct type; otherwise, try 
another terminal type.

Terminal Emulation

Wyse 50: emulates a Wyse 50 terminal with “Enhanced” enabled. 
Wyse 50 emulation may also be used for Wyse 30, 99, 125 and 350 
terminals.

Wyse 60: emulates a Wyse 60 terminal with “Enhanced” enabled. 
Wyse 60 emulation is similar to Wyse 50, but with non-embedded 
visual attributes (the visual attribute codes do not take a position on the 
screen). Wyse 60 emulation may also be used for Wyse 150, 160 and 
320 terminals.

ADDS Viewpoint A2: emulates an ADDS Viewpoint A2 terminal. 
This is the original A2 terminal, with no enhancements.

ADDS Viewpoint 60: emulates an ADDS Viewpoint 60 terminal. The 
Viewpoint 60 is similar to the A2, but uses embedded visual attributes 
(the visual attribute codes take a position on the screen).

Procomm VP60: emulates an ADDS Viewpoint 60 terminal, but with 
non-embedded visual attributes. This emulation is similar to the 
Viewpoint 60 emulation provided by Procomm.

Viewpoint A2 Enhanced: emulates a Wyse 50 terminal in ADDS 
Viewpoint mode with “Enhanced” enabled. This is basically a hybrid of 
Wyse 50 and ADDS Viewpoint A2. Viewpoint A2 Enhanced may also 
be used for ADDS 2020 and 4000, and NCR 2900 terminals.
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MDIS P30 (Prism): emulates a McDonnell Douglas Prism P30 
terminal.

VT52: emulates the DEC VT52 terminal.

VT100: emulates the DEC VT100 terminal. VT100 is a 7-bit 
emulation, and can also be used for applications which require VT102 
terminals.

VT220: emulates the DEC VT220 terminal. The VT220 emulation 
provides a super-set of the VT100 commands, and includes support for 
a host-writable status line, protected characters, multiple character sets 
and multiple pages.

VT320: emulates the DEC VT320 terminal. The VT320 emulation 
provides a super-set of the VT220 commands, and includes support for 
reporting and restoring various terminal states.

VT420: emulates the DEC VT420 terminal. The VT420 emulation 
provides a super-set of the VT320 commands, and includes support for 
rectangle operations, left & right margins, and horizontal split screen.

ANSI BBS: emulates the old MS-DOS ANSI.SYS device driver. This 
emulation may be useful when connecting to older bulletin board 
systems.

Linux Console: emulates the Linux console, including function keys 
and colors.

SCO Console: emulates the SCO Unix console.

Pick PC Monitor: emulates the original Pick PC Monitor (“mm-mon” 
or “I” terminal type), including color and function keys.

Tektronix 4014: emulates the Tektronix 4010/4014 terminals. Color 
enhancements as implemented in the CIT467 terminal (from CIE 
Electronics) are included. 

Tektronix 4100: partially emulates the Tektronix 41xx terminals. 

TTY Emulation: emulates basic TTY functions.
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Status Lines
Some of the terminals that AccuTerm can emulate display status, function 
key labels or host messages on the top or bottom lines of the screen. If you 
select a terminal emulation that supports status lines, the supported status 
line options will be enabled for you to select.

For Wyse and ADDS emulations, up to 3 status lines are available: a host 
message line at the top of the screen, and a “shifted” label line and 
“unshifted” label line at the bottom of the screen. For VT emulations, only a 
single status line is available for displaying a message from the host at the 
bottom of the screen. For the console emulations, the status line is not 
supported.

No message or status line
Select No message or status line if you do not want any status or 
message lines.

Shared message & status line
Select this option to use a single, shared line at the bottom of the 
screen. If the native terminal supports more than one line (Wyse 
and ADDS Viewpoint), the bottom row of the screen displays the 
most recently used line. The line is shared between label line, 
shifted label line and host message line.

Split message & status lines
Select this option if you want two separate status lines. The host 
message line is the top row of the screen display, and the label line 
is displayed on the bottom row. If the shifted label line is 
programmed, pressing the SHIFT key displays the shifted label line. 
Releasing the SHIFT key displays the unshifted label line.

Host Terminal Type
Many hosts allow the client (terminal) to specify a terminal type when a 
connection is established.  AccuTerm uses the default terminal types of tty, 
viewpoint, viewpoint60, wyse50, wyse60, vt100, vt220, vt320, vt420, vt52, 
ansi, linux and pickmon, depending upon the selected terminal emulation.  
If a different terminal type is required, you can enter it in this field.

Use multinational character set
For some emulations, you can select the multinational character set by 
checking this option. If the option does not apply to the selected emulation it 
will not be shown.
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ANSI Options
When any ANSI terminal type (VTxxx, Linux Console or SCO Console) is 
selected, several additional options may also be selected.

Send 8 bit controls
When this option is selected, AccuTerm will send control 
characters from the C0 and C1 sets. If the option is not set, C1 
controls are sent using an equivalent 7-bit escape sequence.

Allow application mode
When this option is selected (default), commands that switch the 
numeric keypad keys and cursor keys into “application mode” are 
recognized. When the option is not selected, those commands are 
ignored, preventing the terminal from switching to “application 
mode”. This option is useful when the host or application 
erroneously sends the command to enter application mode.

Keypad sends application codes
When this option is selected, the numeric keypad sends application 
codes (similar to function keys). When not selected, the numeric 
keypad sends numbers.

Cursor keys send application codes
When this option is selected, the cursor (arrow) keys send special 
application codes instead of cursor movement codes.

Backspace key sends DEL
When this option is selected, the BKSP key sends the DEL control 
code. When not selected, the BKSP key sends the BS control code.

Auto-print works just like VT terminal
When this option is selected, the “auto print” slave printer function 
works the same as a real VT terminal. That is, when AccuTerm is 
in “auto print” mode, the entire screen line that the cursor is on is 
printed when AccuTerm receives a CR, LF or FF control code. If 
this option is not checked, then text is printed as it is received from 
the host (similar to Wyse auto-print mode).
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Screen Settings

The Screen tab lets you set terminal screen options like the screen size, 
cursor type, and history rows. You can also change the session title or icon.

Session Title
This is the text that will be displayed on the session window title bar. If the 
title is blank, the name of the current session configuration file is displayed. 
When the session is maximized, the session title becomes part of the 
AccuTerm main window title.

Session Icon
Each session window has an icon displayed in the window title bar (or menu
bar if the window is maximized). Click the Change… button to select a 
different icon.

Screen Sizes
There are two separate screen sizes that AccuTerm supports: normal and 
extended. These sizes are used to emulate the 80 and 132 columnmodes of 
the Wyse and VT terminals. AccuTerm has taken the extended and normal 
modes one step further. With AccuTerm you can define both the normal and 
extended modes to be any number of columns or rows up to a maximum of 
240 columns by 240 rows.

You will probably leave these settings at their default settings of 80 columns 
by 24 rows for normal mode and 132 columns by 24 rows in extended 
mode. If you have software that supports other screen sizes, you can 
experiment with these settings until you find a size that you like.

The number of rows may change if you change terminal emulations. The 
console terminal emulations use 25 rows with no status line; others use 24 
rows with one or more status lines.

When AccuTerm switches between the normal and extended modes, one of 
two things will happen: either the characters will change size to fit the 
visible screen, or scroll bars will be displayed if the full screen will not fit 
within the current window at the selected character size. For more 
information on scaleable fonts, see the section on Fonts.
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Video Pages
Many of the terminals AccuTerm emulates support multiple addressable 
pages. With AccuTerm, you can have up to 25 pages. Each page requires 
memory, so if you don’t use them, it is better to leave this number set to the 
default value of 1.

History Rows
AccuTerm supports a “history buffer”, which saves lines which have 
scrolled off of the terminal screen.  To use this feature, specify how many 
rows (up to 10,000) are to be saved.  When the history buffer has been 
enabled (by setting the number of rows), use the vertical scroll bar, mouse 
wheel, or keyboard commands to scan history.

You can use CTRL + SHIFT + PGUP, CTRL + SHIFT + PGDN, CTRL + SHIFT

+ UP, CTRL + SHIFT + DOWN, CTRL + SHIFT + HOME, and CTRL + SHIFT + 
END to scan the history buffer.

History Scroll Bar
When a history buffer has been enabled, the vertical scroll bar may used to 
scan through the history. AccuTerm supports three scroll-bar settings.

Auto: when “Auto” (the default mode) is selected, placing the mouse 
near the right edge of the screen will cause the scroll bar to “slide” into 
place. Moving the mouse away from this area causes the scroll bar to 
disappear.

On: when “On” is selected, the scroll bar will always be present.

Off: when “Off” is selected the scroll bar will only be present if the 
window height is not large enough to display the current screen height.

Note: when Auto or Off are selected, using the keyboard commands or 
mouse wheel to scan history causes the scroll bar to be displayed briefly. 
This is so that you can see the position of the scroll button after scrolling 
the window.

Enable Tektronix Graphics
Checking this box enables the Tektronix 4010/4014/4100 graphic terminal 
emulation. If the graphics mode is enabled, AccuTerm will automatically 
switch to the Tektronix graphic emulation when it receives the appropriate 
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command from the host computer. AccuTerm will return to the previous 
emulation mode when graphics mode is terminated.

There may be times when you want to disable the graphic emulation. If you 
have a bad modem connection and are getting random garbage characters on 
the screen, AccuTerm may accidentally switch into graphics mode. 
Sometimes a software program may send the graphics mode control 
sequence at the wrong time. If this happens, disable the graphics mode until 
you need it.

Enable Mouse
This option determines whether host mouse support is enabled. Under 
normal operation, if you click on the terminal screen with the mouse, 
nothing happens. If a “mouse on” command is receivedfrom the host while 
this option is checked, AccuTerm sends a special code informing the host of 
the mouse location when the button was pressed, and which mouse button 
was pressed. The mouse cursor is also changed to a “pointing hand” to 
indicate that the mouse is active.

Block Cursor
Checking this option turns the cursor into a blinking block instead of an 
underline.

Extended Mode
Checking this option sets the screen to extended (132 column) mode. This 
can be used to manually switch between extended and normal (80 column) 
modes.

Disable Line Wrap
When this option is checked, automatic line-wrap is disabled. When the 
cursor reaches the end of a line, typing another character normally causes 
the cursor to move to the beginning of the next line. When this option is set, 
the cursor does not move.

Disable Blinking
Checking this option disables the “blinking” visual attribute.  Characters 
tagged with the blink attribute will not blink.

Disable Underline
Checking this option disables the “underline” visual attribute.  Characters 
tagged with the underline attribute will not be underlined.
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Answerback
The contents of the Answerback field are sent to the host when AccuTerm 
receives a request to transmit the answerback string under Wyse and VT 
emulations.  When the answerback message is sent to the host under Wyse 
emulation, an ACK control character follows the message.  Under VT 
emulation, no terminator is sent.

Control characters may be entered into the answerback field by prefixing the 
character with a caret (̂ ).
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Font Settings

AccuTerm displays text received from the host computer using a fixed-pitch 
font (all characters are the same size). Using a fixed-pitch font is necessary 
because applications written to display on real terminals expect each 
character to be the same size in order to align columns of data on the screen.

AccuTerm supplies a custom font which is used by default. You are free to 
choose another fixed-pitch font if you desire, however, AccuTerm’s font has 
been designed to scale nicely to different screen sizes.

Font
The font list shows all of the available fixed-pitch fonts installed on your 
computer. The first font listed is the AccuTerm font. This font has been 
optimized to look good over a wide range of character sizes and screen 
resolutions. We recommend that you use this font, especially if you have a 
low resolution screen (640 x 480).

To choose a different font, simply click on the font you want to use.

Font Size
This box lists all font sizes available for the selected font. The Font Size list 
is disabled if the Scale Font to Fit option is checked.

Scale Font to Fit
When this option is checked, AccuTerm automatically re-sizes the selected 
font so that the entire terminal screen is visible at the current window size. 
This allows you to re-size the session window or change between normal 
and extended video mode without having to deal with scroll bars to see 
everything. However, if for some reason, you need lock the characters at a 
specific size, you can un-check this setting and then pick the size you want 
from the Font Size list.

Use Bold Font Style
If this option is checked, AccuTerm uses the Bold font style if it's available 
in the selected font.
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Keep Font Legible
If this option is checked, and the Scale Font to Fit option is checked, 
AccuTerm will never scale a font smaller than 6 pixels wide by 9 pixels 
high.

Host uses Windows character set
Use this option to change the default character set used by the selected 
terminal type to the 8-bit (non-Unicode) character set used by Windows.  
You will need to select a font that supports all the characters in the 
Windows character set if this option is checked; the AccuTerm font only 
supports the OEM (code page 437) and Western ANSI (code page 1252) 
character sets.

Euro character
If your host application needs to display the Euro currency symbol, enter the 
ASCII value of the Euro symbol, as used on your system.

Note: there is no standard value for this symbol. Some possible values are 
128 (Windows ANSI), 164 (Latin-1 currency and Latin-9 Euro) and 213 
(IBM modified code page 850).
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Color Settings

Windows is capable of displaying text in a wide variety of colors. The 
colors are separated into character color and the background color. Most of 
the terminals being emulated do not support color. Instead, they have visual 
attributes like normal, reverse, dim, blink, underline, etc. AccuTerm allows 
you to map the various terminal visual attributes into a combination of 
character and background colors.

AccuTerm uses a palette of 16 colors. Since most systems are capable of 
displaying more than 16 colors, AccuTerm allows you to customize its 
palette by selecting a Color Scheme or Visual Style, or by clicking the 
Customize Palette… button. The palette also includes 6 colors used to 
draw borders when using Visual Styles.

The mapping of visual attributes to colors is displayed as a table with an 
entry for each possible attribute. The Color column shows sample text 
displayed in the selected character and background color along with a button 
to change the colors. The Border column shows the selected border style 
for the attribute. Click the Change button to select different character or 
background colors. If borders are enabled (see Border Style below), choose 
the border effect for the attribute from the drop-down list.
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Color Schemes

Default Colors: resets the palette to the 16 basic Windows colors, and 
resets the attribute color mapping. This is often a useful starting point 
when defining your own color mapping.

System Colors: sets several colors in the palette to “system colors” 
defined in the Windows Display Properties. The following standard 
colors are replaced by a system color:

Black = Window Text Color
White = Window Background Color
Dark Blue = Highlight Background Color
Brown = Highlight Text Color
Light Gray = 3D Light
Dark Gray = 3D Shadow

Other palette colors are set the same as the default colors. Attribute 
color mapping is set so that Normal, Dim, Reverse and Underline use 
system colors from the modified palette.

Monochrome Colors: resets the palette to the 16 basic Windows 
colors, then sets the atttribute color mapping so that characterand 
background colors are black, white or gray. Select either dark or light 
background for the Normal attribute. This setting often works well with 
Unix and Linux utilities where a combination of visual attributes and 
direct colors are used.
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Visual Styles
Visual Styles can be use used to modernize character-based applications by 
displaying screen elements in a style that resembles typical Windows 
screens. When you select a Visual Style, AccuTerm resets the palette to the 
system colors as described above. Next, typical Windows colors are 
assigned to the visual attribute mappings. Then the Border Style setting is 
changed to Thin and a border effect is assigned to specific attributes.

When using Visual Styles, use the following attributes to display screen 
elements:

Screen background: normal
Field labels, headings, etc: normal
Disabled labels: dim
Active entry field: reverse
Inactive entry field: dim reverse
Highlighted field: reverse underline
Disabled field: dim reverse underline
Command button: underline
Inactive button: dim underline

Classic Windows: sets the palette to the system colors, and sets the 
attribute color mapping as described above. Uses the inset border style 
for text fields.

Windows XP: sets the palette to the system colors, and sets the 
attribute color mapping as described above. Uses the flat border style 
for text fields.

If your application uses different attributes for screen elements, feel free to 
modify the colors and border effects to work with the attributes used by the 
application.
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Protected Attribute
The Wyse 50 and Wyse 60 emulations require a visual attribute to be 
assigned as the “Protected” attribute. To select the Protected Attribute, 
click on the drop-down arrow, then select which visual attribute should be 
used as the default protected attribute.

Border Style
If you are using Visual Styles (or the AccuTerm private programming 
command to draw borders), you must select a border style. Choose thin for a 
one-pixel border, or thick for a two-pixel border. When external borders are 
selected, vertical border lines are drawn in adjacent character cells. 
Otherwise they are drawn inside the character cell andsometimes overlap 
the left or right edge of the character; thin borders work best with smaller 
font sizes, but are less dramatic than thick borders.

Line Drawing
AccuTerm supports the line and box drawing characters used by the native
terminals. AccuTerm supports three line drawing styles: normal, flat and 
beveled. Choose normal to draw lines using the current character color. 
Choose flat to draw lines using the outer flat border color. Choose beveled
to draw 3D lines using the outer highlight and outer shadow colors.
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Keyboard Settings

AccuTerm supports a programmable keyboard. All of the function keys and 
most of the keypad editing keys can be programmed.

Each terminal type has default programming for all of the keys which are 
native to that terminal. You do not need to program the default key codes. 
The default codes are displayed in gray text.

If you wish to override the default programming, or to program keys that are 
not native to the currently selected terminal type, you can enter you own 
codes here. Any key can be programmed with a character sequence (which 
is transmitted to the host when the key is pressed), or a script command, 
which is executed when the key is pressed.

The programmable keys are divided into eight categories: Normal, Shifted, 
Control, Shift+Control, Alt, Shift+Alt, Keypad and Shifted Keypad. The 
Normal key sequence is sent when one of the function keys is pressed by 
itself. The Control sequence is sent when a function key is pressed while 
holding down the CTRL key. The Alt sequence is sent if the ALT key is held 
down while pressing a function key. The Keypad sequence is sent when one 
of the editing keys is pressed. The Shifted, Shift+Control, Shift+Alt, and 
Shifted Keypad sequences are sent when the SHIFT key is held down in 
combination with any of the previous keys.

The Keypad and Shifted Keypad tabs are used for programming the 
special editing keys: BKSP, TAB, INS, DEL, HOME, END, PGUP, PGDN, 
LEFT, RIGHT, UP, and DOWN.

To reset the selected group of keys to their default values, click the Reset all 
to default button.
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Key Code
To manually program function and keypad keys, first select the Key Type
from the tabs at the top of the panel. Next, enter the desired sequence into 
the Key Code field. next to the key name. To enter control characters, hold 
the CTRL key and press the letter corresponding to the control character you 
want to program. For CR (enter), DEL (delete) and TAB control codes, hold 
the CTRL key and press the ENTER, DELETE or TAB key.  For the ESC
control code, press CTRL + [ , and for the BS (backspace) control code, 
press CTRL + H.

The carat (^) and backslash (\) characters are used as special prefixes in 
keyboard programming. If you need to enter either of these characters, just 
enter two of them (^^ or \\). This applies to both codes to transmit to the 
host and script commands.

Alternatively, use the following table to enter control codes using special 
prefix characters:

Key
sequence

Control
code

AccuTerm
notation

Key
sequence

Control
code

AccuTerm
notation

CTRL + @ NUL ^@ CTRL + P DLE ^P

CTRL + A SOH ^A CTRL + Q DC1 ^Q

CTRL + B STX ^B CTRL + R DC2 ^R
CTRL + C ETX ^C CTRL + S DC3 ^S
CTRL + D EOT ^D CTRL + T DC4 ^T

CTRL + E ENQ ^E CTRL + U NAK ^U

CTRL + F ACK ^F CTRL + V SYN ^V

CTRL + G BEL ^G CTRL + W ETB ^W

CTRL + H BS ^H CTRL + X CAN ^X

CTRL + I HT ^I CTRL + Y EM ^Y

CTRL + J LF ^J CTRL + Z SUB ^Z

CTRL + K VT ^K CTRL + [ ESC ^[

CTRL + L FF ^L CTRL + \ FS ^\

CTRL + M CR ^M CTRL +] GS ^]

CTRL + N SO ^N CTRL + ^ RS ^~

CTRL + O SI ^O CTRL + _ US ^_
^ ^^ \ \\
DELETE DEL ^?
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To program a key with a script command, enclose any valid VBA statement 
in square brackets ([ ]). See the Scripting section of the Programmers 
Guide for more information on scripts.

Key Caption and Tip
When the Function Bar is displayed, you can enter a caption for each 
function key. The caption will override the default button caption in the bar 
for that key. Enter the caption in the Caption | Tip field. Strive to keep the 
caption text short, as the key buttons are quite small. You can also enter an 
optional help tip in this field. Separate the caption and tip using a vertical 
bar (|). When the mouse hovers over the key button in the Function Bar, 
the tip will be displayed briefly.

You can enter a tip even if you do not enter a caption or display the 
Function Bar. Just begin the Caption | Tip field with a vertical bar and 
enter the tip. This is useful for documenting the purpose of the key 
programming

Locking Programmed Keys
Most terminal types provide commands for the host to program the function 
keys. If you would like the host to be able to reset and reprogram the keys, 
select the Unlocked – host can reset or reprogram key option. If you 
would like the host to be able reprogram keys, but not reset them to their 
default values, select the Locked – host cannot reset keys to defaults
option. If you would like to prevent the host from resetting or 
reprogramming key, select the Locked – host cannot reset or reprogram 
keys option.

Mapping F11 through F16
Some terminals (like Wyse 50 and 60) have more than 12 function keys on 
their native keyboard. Since the PC keyboard only has 12 function keys, 
AccuTerm allows you to map the native F11 through F16 keys to PC 
keyboard CTRL + F1 through CTRL + F6 (and native SHIFT + F11 to SHIFT + 
F16 to PC CTRL + SHIFT + F1 through CTRL + SHIFT + F6).

Start with CapsLock On
Sometimes applications are designed for upper-case text. If you would like 
the CapsLock key state to be "on" when the session is opened, check this 
option.
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Copy / Paste Shortcut
AccuTerm supports standard Copy and Paste functions using the Edit menu 
or the context (right-click) popup menu. You can also choose shortcut keys 
for these functions: CTRL + INS / SHIFT + INS or CTRL + C / CTRL + V. 
However, if you select the shortcut you will no longer be able to use the 
normal function of the shortcut keys. For example, if you select CTRL + C / 
CTRL + V for your Copy / Paste shortcut, you will not be able to send the 
CTRL + C control character anymore.
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Printer Settings

AccuTerm 2K2 uses the printer in two ways: First,AccuTerm can print the 
contents of the terminal screen by using File Print Screen menu command 
(or toolbar button), the ALT + G keyboard command, or by receipt of the 
appropriate command from the host computer.

The other way AccuTerm uses the printer is to emulate a “slave” printer 
attached to a terminal’s Aux (printer) port. This mode is enabled by using 
the File Printer On menu command, the ALT + P keyboard command, or by 
receipt of the Printer On command from the host. The state of the “slave 
printer” is indicated on the status bar (Idle, Off or On).

When AccuTerm receives a Printer On command from the host (or by using 
the File Printer On menu command or ALT + P keyboard command), the 
printer status shown in the status bar is changed to On. When the Printer Off
command is received, the status changes to Off. If another Printer On
command is not received before the number of seconds specified in Printer 
Close Timeout, the print job is closed, and the status changes to Idle.

AccuTerm can print in two modes: text and graphics. Text is the mode used 
by “real” terminals. This mode is different from normal Windows printing in 
that the Windows printer driver is not used. For screen printing, text mode 
sends the screen text to the printer. For slave printing, AccuTerm passes raw 
data, including control characters and escape sequences from the host 
directly to the printer (or spooler). In text mode, the host computer is 
responsible for setting printer font sizes and page orientation by sending the 
appropriate printer commands.

In graphics mode, AccuTerm prints an image of the screen on the printer, 
using the Windows printer driver. When the screen is printed in graphics 
mode, the printed image includes text, line drawing characters, any images 
displayed on the screen, and may optionally include the screen background 
and colors. For slave printing, AccuTerm understands CR (carriage return), 
LF (line feed) and FF (form feed) control characters, but other control 
characters and escape sequences are ignored.
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You can select the paper size and page orientation used for graphics mode 
printing by clicking the Page Setup button in the printer settings tab. For 
slave printing in graphics mode, you can also select the font.

AccuTerm can also use print adapter scripts to process slave print jobs. See 
below for details.

Printer Selection
By default, AccuTerm uses the system default printer (the Use Windows 
Default Printer option selected). If you want to select a different printer, 
select the Use Specific Printer option, then select a printer from the drop-
down list. If you want to disable printing from AccuTerm, select the Disable 
printing option.

Screen Print Settings
AccuTerm can print the screen in Text or Graphics modes. In Text mode, 
only the text characters currently displayed on the screen are printed. In 
Text mode, you can elect to eject the page from the printer before the 
printout, after the printout or both.

In Graphics mode, an “image” of the current screen is printed, including 
special symbols like line drawing characters. You can elect to print the 
background (shading and highlighting) or print the screen in color if you 
have a color printer. In Graphics mode, you can select the page orientation, 
paper size and paper source by clicking the Page Setup button.

Slave Printer Settings
AccuTerm can print to the slave printer in either Text or Graphics mode. In 
Text mode, you can eject the page from the printer before the printout, after 
the printout or both. In Graphics mode, you can select the font, page 
orientation, paper size and paper source by clicking the Page Setup button.

If you have configured any print adapter scripts (see below), you can select 
one of these as well. See the discussion above for the differences between 
text and graphics modes.
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Printer Close Timeout
Enter the number of seconds to wait after receiving a Printer Off command 
before closing the print job. Usually, when the host computer needs to print 
a report, it usually sends a Printer On command, sends the printer data and 
then sends a Printer Off command. But some host programs send a Printer 
On command, send some data to the printer, send a Printer Off command, 
and send some other data to the screen, and then send another Printer On
command, and send more data to the printer, etc. Because of this, AccuTerm 
has no way of knowing when the host is finished sending the print job. The 
only way it can determine this is to wait for a set amount of time after the 
Printer Off command before closing the job. If this field is set to the default 
of 5 seconds, AccuTerm waits 5 seconds after the Printer Off command has 
been received before closing the print job.

This causes a delay when printing under AccuTerm. If all your host 
programs always turn the aux port on, send all the data and then turn it off, 
you can reduce this number to 1 or 0. If you have programs that are 
constantly turning the aux port on and off, you may need to adjust this 
number until things work correctly.

Print Adapter Configuration
For slave printing, AccuTerm can utilize a print adapter script to process a 
print job (file). The adapter script can launch command-line print utilities 
such as PrintWizard (from Rasmussen Software). PrintWizard can print 
jobs that contain Hewlett Packard  PCL on most any Windows printer, even 
if the printer does not have native PCL support. This is quite useful if you 
use PCL-formatted reports and forms in your application, but have newer 
printers without PCL (or even text) support. Click the Click here to 
configure print adapters link on the Printer tab to choose available print 
adapters, then select the desired adapter from the dropdown list on the 
Printer tab. If you have PrintWizard installed on your PC, you can select 
the included PrintWizardPCL adapter script to enable PCL printing on non-
PCL compatible printers. You can also create your own custom adapter 
scripts, using the supplied PrintWizardPCL.atsc script as an example. Using 
this feature, you can use external programs to convert your slave printer 
reports and forms to PDF files, email or fax.
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File Transfer Settings

AccuTerm supports several file transfer protocols. The File Transfer tab 
allows you to adjust some of the parameters used control the various 
protocols, select default operating modes and specify default directories. 
There are sections for ASCII options, X/Y/Zmodem options, Kermit 
options, as well as options for default modes and directories.  The default 
values for most of these options should not be changed without an 
understanding of the protocol and the companion file transfer program on 
the host computer.

ASCII Settings
When transferring a file from your computer to the host computer (upload) 
using the ASCII protocol, the each line may be terminated with a CR, LF or 
CR LF combination.  Select the appropriate end of line for the host computer 
by checking the appropriate button.

ASCII is a “blind” protocol.  The receiving computer cannot inform the 
sending computer when it is safe to transmit data.  In order to perform 
reliable ASCII uploads, you may need to specify an appropriate Interline 
delay time.  After each line is sent to the receiving computer, AccuTerm 
will wait for the specified time before sending the next line.  Specify this 
value in milliseconds.

Note: the Interline delay setting also applies to the Edit Paste and Edit 
Paste From commands.

Timeout Settings
When using any of the X/Y/Zmodem protocols, you can specify the number 
of seconds before a timeout occurs.  If the other machine fails to respond 
within the number of seconds specified here, the protocol will attempt to 
resend the previously sent message.
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Kermit Settings
The Kermit file transfer protocol is popular with minicomputer and 
mainframe systems.  There have been many revisions of this protocol, and it 
may be necessary occasionally to modify some of these settings to 
communicate with another Kermit program.

Kermit settings: Defaults
These default options may be set (checked) or reset (un-checked) as desired.  
When AccuTerm Kermit is negotiating with the other Kermit program, any 
of the checked options will be requested, and if the other Kermit is capable, 
the option will be used.

Quote eighth bit: select this option when the communications path 
only supports 7 data bits, or when the other machine is not capable 
of processing eight bit data.

Compress data: selecting this option causes Kermit to perform 
rudimentary data compression.  Not all Kermit programs perform 
data compression.

CRC block check: select this option to use CRC error detection
instead of the standard simple checksum error check.  This results 
in more reliable transfers, especially over noisy phone lines.  Not 
all Kermit programs perform CRC error checking.

Default Mode
Select Text or Binary as the default transfer mode (used only for Kermit 
and Zmodem protocols).  When you select Upload or Download from the 
main menu or toolbar, the default mode will be selected.  Also, select 
whether to overwrite existing files when downloading.  You also can change 
any of these options in the Upload or Download dialog before performing 
the transfer.

Default Upload/Download Directory
Enter the drive and directory where you want received files to be stored by 
default.  You can change this directory in the Download dialog before 
performing the transfer.  If you set the Automatic Zmodem download
option, then this is the directory where the received files are stored.
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Automatic Zmodem Download
If this option is set, then AccuTerm will automatically begin receiving files 
using the Zmodem protocol when the other machine begins sending files 
using the Zmodem protocol.  The files are saved in the Default 
Upload/Download directory.



Configuring AccuTerm 63

Miscellaneous Settings

The Miscellaneous Settings tab is used for setting various options, such as 
how paste operations are handled and the sound of the terminal bell.

Paste Options: line end
When the clipboard is “pasted” to an AccuTerm session, AccuTerm 
transmits the clipboard text to the host computer. The line end options 
specify what is transmitted at the end of a line of text. Options include CR 
(default), LF, CF+LF, TAB, none or a user-defined character. To specify a 
user-defined character, select the User defined option and enter the ASCII 
code of the character to be transmitted at the end of each line.

Paste Options: do not send line end after last line
If you want to suppress the final end-of-line (or only end-of-line if only a 
single line is in the clipboard), select this option.

Paste Options: paste end
After pasting the clipboard to an AccuTerm session, AccuTerm can transmit 
an optional paste end character. Normally, AccuTerm does not transmit any 
character at this time, but you can select EOF (which is the SUB or CTRL + 
Z control code), or a user-defined character. To specify a user-defined 
character, select the User defined option and enter the ASCII code of the 
character to be transmitted at the end of a paste operation.

Terminal Bell Sound
The sound generated by AccuTerm upon receipt of the ASCII BEL control 
code can be customized. The default sound depends upon whether a sound 
card is installed or not. If a sound card is not installed, a “beep” is produced; 
otherwise the sound defined by the Control Panel “Sounds” applet as the 
“Default Beep” is played.

Other options which may be selected are: play wave file, system event, 
beep or silent. To play a wave file, select this option and enter the full path 
for the wave file to be played. To use a sound associated with a system 
event, select the event from the dropdown list. System events are associated 
with wave files in the Control Panel “Sounds” applet. To use a true beep, 
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enter the frequency of the beep in Hz, and the duration in milliseconds. The 
default is 400Hz for 500ms. The frequency must be between 200Hz and 
4000Hz. The duration must be between 100ms and 5000ms.

Advanced (Custom Features)
Click the Advanced button to show any custom features that can be 
selected. See the Programmers Guide for more information on the custom 
features of AccuTerm 2K2.
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AUTO DIALER

The AccuTerm Auto Dialer gives you an easy way to store and dial phone 
numbers. The Phone directory list contains all the phone numbers in the 
current directory file. You can have as many phone numbers in a directory 
file as you want. You can also have any number of directory files. The 
default directory file name is set in the General tab of the Settings dialog 
box (Tools Settings menu).

To access the Auto Dialer, select the Tools Dialer menu item or click the 
button on the toolbar.

Note: the Auto Dialer is only available if the current session is configured 
to use a Modem for its connection.

Dialing
Using the Auto Dialer is very simple. To dial a number, double click an 
entry in the phone directory, or highlight the desired number in the phone 
directory list then click the Dial button.

If you want to dial a number which is not in the directory, simply enter the 
desired phone number in the Number field, then click Dial.

Hanging Up
To terminate a connection, click the Hang Up button.

Adding a new entry
To add a new entry to the directory, click on the New button.  Enter a phone 
number and optional description, then click the Add button.

Deleting an entry
To delete the selected entry, click the Delete button.
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Modifying an entry
To change an existing description or number, select the entry you want to 
change, modify the description or number and click the Edit button.

Creating a new directory file
To create a new phone directory file, click the Change Directory button.
From the Open Phone Directory File dialog, select the drive and directory 
for the new phone directory file, and enter the new phone directory file 
name. Click OK to create the new phone directory file.

Changing directory files
To select a different phone directory file, click the Change Directory
button, then select the new phone directory file. Click OK.

Changing dialing options
To change the dialing options such as your current location, area code, 
dialing prefix, credit card information, etc., click the Dialing Options
button.

Directory file format
Phone directory entries are stored in a standard tab delimited ASCII text file 
with a file extension of .dat. The name is the first field and the phone 
number is the second field. Each entry has its own line. Many applications 
have the ability to export data to ASCII files so it may be possible to use 
your existing phone directories from other applications with the Auto Dialer.
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FILE TRANSFER

AccuTerm has the ability to transfer files between your computer and a 
remote machine using one of the five built in file transfer protocols: ASCII, 
Kermit, Xmodem, Ymodem and Zmodem. The standard (non-MultiValue) 
file transfer functions are accessed from the Tools menu by selecting the 
Upload or Download items or by clicking on the or buttons on 
the toolbar, then selecting Manual Download from the selection panel.

For MultiValue users, AccuTerm 2K2 includes a File Transfer Wizard that 
simplifies the file transfer process by asking a series of simple questions and 
letting you click, enter or browse for the answers. To start theFile Transfer 
Wizard, select Upload or Download from the Tools menu or by click on 
the or buttons on the toolbar, then select Upload Wizard (or 
Download Wizard) from the selection panel. In order to use the File 
Transfer Wizard, the AccuTerm 2K2 host programs must be installed on 
your MultiValue host system.

AccuTerm also includes command-line style file transfer utilities for 
MultiValue systems. These utilities are installed along with the host 
programs. For users of MultiValue based systems, using the File Transfer 
Wizard or the command-line utilities is the recommended method of 
exchanging data between your PC and the host computer.
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Installing the MultiValue Host Programs

The AccuTerm host programs for MultiValue systems are written entirely in 
BASIC. AccuSoft recommends that the host programs be installed into a 
dedicated account (usually the ACCUTERM account) on your host system. 
Once installed, the programs can be shared with other accounts on the 
system. To install the host programs on your MultiValue system, perform 
the following steps:

1) Open a terminal session and connect to your MultiValue host 
system. Log on to the ACCUTERM account, or another account 
where you want to install the AccuTerm host programs. Check the 
following items before beginning the installation:

a) Make sure you are at a command prompt (TCL, ECL, 
etc.)

b) If your system has a “case inversion” feature, disable it 
(PTERM CASE NOINVERT).

c) If your system blocks control characters, disable the 
blocking (CONTROL-CHARS ON).

d) If your system is running on a Unix or Linux host, make 
sure that the CTRL + A control character can be input. 
Check by typing stty -a at a Unix prompt – look for 
^A - if you find it, either disable that function or map it to 
a different control character. For example if you see 
something like susp = ^A you can type stty susp 
\^- to disable the suspend function.

e) Enable type-ahead. Most systems have type-ahead enabled 
all the time, however you might need to enable type-ahead 
on a per-port basis on some systems (TA-ON or 
TYPEAHEAD-ON).

f) If you are installing on a jBase system, be sure you have 
an MD file, and that your terminal type is set correctly 
before installing the host programs.

g) Check the Paste Options – Line End setting in the 
Settings dialog, Misc tab and ensure that the “CR” option 
is selected. Ensure that the “Do not send line-end 
after…” option is not selected.
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2) While at the command prompt (TCL, ECL, etc.), click on the Edit
menu and select Paste From. 

3) Browse to the PickBP folder. 

4) Click on the install script for your platform (please see the 
readme.txt file in the PickBP folder for the latest platform list): 

FTPINST.TXT generic MultiValue system
FTPINSADDS.TXT Mentor, Mentor Pro, MOE
FTPINSAP.TXT Advanced Pick
FTPINSAP_AIX.TXT Advanced Pick on AIX
FTPINSAP_PRO.TXT Advanced Pick / Pro
FTPINSD3.TXT D3 (NT, Linux, Unix except AIX) 
FTPINSD3_AIX.TXT D3 on AIX
FTPINSENH.TXT Enhanced R83 (Altos, Fujitsu, R91, 

etc.) 
FTPINSJB.TXT jBase
FTPINSJB_AIX.TXT jBase on AIX
FTPINSMD.TXT Reality
FTPINSMV.TXT mvBase
FTPINSNR.TXT Northgate Reality 9+
FTPINSOI.TXT Revelation OpenInsight CTO
FTPINSON.TXT ONWare MVON
FTPINSPWR95.TXT Power 95
FTPINSQM.TXT QM MV Database
FTPINSR83.TXT Pick R83
FTPINSSEQ.TXT Sequoia, mvEnterprise (except 

Ultimate emulation) 
FTPINSSEQ_AIX.TXT Sequoia, mvEnterprise on AIX
FTPINSUD.TXT UniData
FTPINSUD_AIX.TXT UniData on AIX
FTPINSULT.TXT Ultimate Plus (all except SCO Unix 

and AIX) 
FTPINSULT_AIX.TXT Ultimate Plus on AIX
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FTPINSULT_SCO.TXT Ultimate Plus on SCO Unix
FTPINSULTX.TXT Early Ultimate (as implemented on 

mvEnterprise) 
FTPINSULTX_AIX.TXT Early Ultimate (as implemented on 

mvEnterprise) on AIX
FTPINSUV.TXT UniVerse
FTPINSUV_AIX.TXT UniVerse on AIX
FTPINSVIS.TXT UniVision

5) Click the Open button. AccuTerm will install a small PROC and 
bootstrap program which will be used to install the core file 
transfer programs. You will see the PROC and bootstrap programs 
as they are entered into the host MD and FTBP files. Once the 
bootstrap program has been installed, it will run automatically and 
complete the installation of the core programs (FTBP file).

Once the main host programs are installed, a dialog box will be 
displayed where you can select any optional program libraries 
(GUI, ObjectBridge, SUI) and sample programs and data that you 
want to install.

6) If you have previously installed the ViaDuct host programs, the 
ViaDuct FT proc conflicts with AccuTerm’s FT program. If this 
conflict is detected, the AccuTerm installer will prompt if you want 
to rename the ViaDuct FT command as “FT.VIA”. Answer Y to 
rename.

7) If need to reinstall the host programs, or install an updated version, 
or would like to install any of the optional libraries at a later time, 
just type LOAD-ACCUTERM-PROGS at TCL and select the 
desired options from the dialog.
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Activating Other Accounts to use the Host Programs
After installing the host programs on one account on your host system 
(usually the ACCUTERM account), you can easily activate these programs 
on other accounts. To activate the programs on another account, perform the 
following steps:

1) Log on to the ACCUTERM account (or other account where you 
have installed the host programs).

2) At TCL, type FTSETUP. The FTSETUP program will display a 
menu. Enter 1 (Account Setup) and press ENTER.

3) When prompted for the account name to activate, type the name 
and press ENTER.

4) Type X and press ENTER to quit the FTSETUP program.
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MultiValue File Transfer

To make the most effective use of AccuTerm with your MultiValue host 
system, you should install the AccuTerm host programs. These programs 
implement the Kermit and ASCII file transfer protocols, coordinate the 
transfer of data between your computer and the host, import and export data 
in a variety of formats, provide a simple host-to-host transfer facility, and 
enable the use of the wED program and text editor.

In order to understand how to best use AccuTerm’s MultiValue file transfer 
features, the differences between the PC and MultiValue file systems must 
be examined.  Traditional PC files may be programs, documents or data 
files; in the typical MultiValue system, programs and documents are stored 
as individual items (records) in a file, whereas a data file is collection of 
related items (records) in a file, with an associated file dictionary.

When exchanging data between your computer and your MultiValue host, it 
is important to realize the difference between “document files” and “data 
files”.

Although AccuTerm supports both Kermit and ASCII protocols, Kermit is 
the recommended file transfer protocol because of the automatic error 
detection and correction.  Also, even with the increased overhead ensuing 
from Kermit, because the sender and receiver are synchronized and no time 
delays are required, the Kermit protocol usually performs better than the 
ASCII protocol when receiving a file.

File Transfer Wizard

After installing the AccuTerm host programs, you can use the File Transfer 
Wizard to exchange data between your MultiValue host and your PC.To 
start the File Transfer Wizard, select Upload or Download from the Tools
menu or by click on the or buttons on the toolbar, then select 
Upload Wizard (or Download Wizard) from the selection panel. You can 
also start the wizard by using the FTWIZ verb at TCL.
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The File Transfer Wizard will guide you through the download or upload 
process by displaying a series of small panels, with simple questions on 
each. Simply fill in the answers or click on the desired options. When you 
get to the last step, you can click the Run Job button to execute the transfer. 
You can also save the job to a file on your host or to local file on your PC. 
This way, you can reuse the same job over and over, and can even automate 
a transfer by using the FTWIZ verb with a saved job:

FTWIZ  filename  jobname (R

While using the wizard, you can use the Next and Back buttons to move 
between steps. Online help is available for each step in the wizard; just click 
the Help button.
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Command-Line File Transfer Utilities

When transferring “document files” between the PC and MultiValue host, 
use AccuTerm’s FT utility.  This utility transfers MultiValue items to PC 
files and vice versa. The key concept is that each MultiValue item becomes 
a separate file on the PC.

When transferring “data files” between your PC and your MultiValue host, 
use the FTD utility.  This utility transfers a set of MultiValue items to a 
single PC file and vice versa. The key concept is that a set of items on the 
host becomes a single file on the PC.

You can also use AccuTerm to transfer data between two MultiValue hosts. 
The FTPICK utility is used to transfer data from one MultiValue machine 
to another, either directly (using two concurrent AccuTerm sessions), or 
using an intermediate PC file.

Downloading Documents to Your PC
Use the FT utility to send items (documents) from your MultiValue host to 
your PC.  FT downloads each item (document) into a separate PC file.  
Normally, FT uses text mode, converting attribute marks to CR/LF during 
the download process.

To download using FT, enter FT at the command prompt.  When prompted:

(S)end, (R)eceive, (C)onfigure, (O)ptions, 
(H)elp or (E)xit ?

Answer S to send, then select the file transfer protocol:

File transfer protocol: (A)SCII or (K)ermit ?

Kermit is recommended.

Enter source (Pick) file name:
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Enter the name of the host file which contains the items to be sent.

Enter source (Pick) item list:

Enter the item-IDs to be sent.  If you do not enter item-IDs, any previously 
selected (SELECT, GET-LIST, etc.) items will be transferred; if you enter 
an asterisk (*), all items in the file will be transferred.  To specify a saved 
list, enter an open parenthesis followed by the list name.  Separate item-IDs 
with blanks.

Enter target (DOS) directory name:

Enter the PC directory name including drive letter if desired.  Separate 
directory names in a full path using back-slashes. UNC-style file names are 
acceptable.

Enter target (DOS) file name:

Enter the PC file name, including extension.  If multiple items are being 
sent, multiple file names may be specified here.  Each host item will be 
written to a separate PC file.  If no file names are specified here, the item-ID 
will be used as the PC file name.

When the transfer is complete, you may see a message like:

Converting file to ANSI character set . . .

This indicates that the raw data has been downloaded and is being converted 
from the OEM character set to the ANSI (Windows native) character set.
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Uploading Documents from Your PC to the Host
Use the FT utility to send PC files to your MultiValue host. Each PC file 
uploaded is saved as an item in the host file you specify.

To upload using FT, enter FT at the command prompt and follow the 
prompts.

(S)end, (R)eceive, (C)onfigure, (O)ptions, 
(H)elp or (E)xit ?

Answer R to receive, then select the file transfer protocol:

File transfer protocol: (A)SCII or (K)ermit ?

Kermit is recommended.

Enter source (DOS) directory name:

Enter the name of the PC directory which contains the files to be uploaded.

Enter source (DOS) file name:

Enter the name(s) of the PC file(s) to be received.  Separate multiple file 
names with blanks.  Wildcard characters (? and *) are valid.

Enter target (Pick) file name:

Enter the host file name where the uploaded files are to be saved.  Each 
uploaded file is stored as an item in this file.

Enter target (Pick) item list: 

Enter the item-ID(s) for the uploaded file(s).  If multiple files are being 
uploaded, multiple item-IDs may be specified here.  If no item-IDs are 
specified here, the PC file name will be used as the item-ID.

Before the transfer begins, you may see a message like:

Converting file to OEM character set . . .

This indicates that the PC file, which uses the ANSI (Windows native) 
character set is being translated into the OEM character set prior to transfer 
to your host computer.
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FT Options and Settings
Several configuration (permanent) and option (temporary) settings are 
available for the FT utility. The permanent configuration settings are used 
as the default values for the temporary option settings.

FT Configuration Settings
To change configuration (permanent) settings, enter C in response to the 
first prompt.  A list of configuration settings will be displayed:

Current parameter settings are: 
1. Transfer mode Text
2. Preserve file extension Yes
3. Overwrite existing item Yes
4. Large item treatment Truncate
5. Convert OEM char set to ANSI   No

Enter parameter number (1-5) to modify:

The setting for any of these items may be changed by entering the item 
number and pressing ENTER..

Transfer Mode
Possible transfer modes are text and binary.  Text causes attribute mark 
characters to be translated to carriage return / line feeds and vice versa.

Preserve File Extension
When the Preserve File Extension option is enabled, DOS files that are 
uploaded retain their extension. That is, if you upload a file called 
REPORT.TXT, the item ID used to store the uploaded file is 
REPORT.TXT. If this option is not enabled, the item ID used would simply 
be REPORT.

Overwrite Existing Item
When the Overwrite Existing Item option is enabled, any existing file 
(download) or item (upload) will be overwritten with the new data. If the 
option is disabled, existing items are not overwritten.

Large Item Treatment
Large Item Treatment may be set to truncate items at about 30000 bytes, 
split large items into multiple items of about 30000 bytes each, or no action 
(for those systems with no item size limitation).  Split items use a special 
item-id generated by concatenating the original item-id, an underscore (_), 
and a sequential number starting with 001.
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Convert OEM Char Set
If you enable OEM/ANSI character set conversion, the file you upload or 
download is a temporary file. The actual file is converted before uploading 
and after downloading. You should not enable this option unless you use 
international characters on your MultiValue host, and those characters are 
stored using the OEM character set (the set used by ADDS Viewpoint, 
Wyse, ANSI BBS and PC Monitor emulations).

FT Option Settings
To change option settings, enter O in response to the first prompt.  A list of 
option settings will be displayed.  Note that the default value of the options 
is obtained from the configuration settings:

Current parameter settings are:
1. Transfer mode Text
2. Preserve file extension Yes
3. Overwrite existing item Yes

The setting for any of these items may be changed by entering the item 
number and pressing ENTER..

An alternate way to set the value of an option setting is to answer the prompt 
with the item number, an equal sign, and the first letter of the value to which 
the parameter is to be set.  For example, to set the Transfer Mode to 
“binary”, respond to “Enter parameter...” with 1=B.  This alternate method 
is useful in cases where the FT utility is being “driven” by a PROC or by 
another program using the EXECUTE statement.

The meanings of these option settings are the same as the configuration 
settings described previously.
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Downloading Data Files to Your PC (Export)
Use the FTD utility to download a set of specified (or selected) items from 
your host database to a PC file.  You can specify which fields (attributes) to 
download.  The target PC file format is determined by the file name you 
specify.

FTD can also be used to join several host items into a single PC file. This is 
done by setting the field delimiter to “CrLf”, and entering an asterisk at the 
“Source item list” prompt

To export data from the host using FTD, enter FTD at the command prompt, 
then answer the prompts.  On-line help is provided for each prompt, just 
enter a question mark and press ENTER.

(S)end, (R)eceive, (C)onfigure, (O)ptions, 
(H)elp or (E)xit ?

Answer S to send, then select the file transfer protocol:

File transfer protocol: (A)SCII or (K)ermit ?

Kermit is recommended.

Enter source (Pick) file name:

Enter the name of the host file which contains the data to be exported.

Enter source (Pick) item list:

Enter the item-IDs of the items (records) you want to export.  If you do not 
enter any item-IDs, any previously selected (SELECT, GET-LIST, etc.) 
items will be exported; if you enter an asterisk (*), all items in the file will 
be exported.  To specify a saved list, enter an open parenthesis followed by 
the list name.  Separate item-IDs with blanks.

Enter target (DOS) file (path) name:

Enter the full PC file name including drive letter and directory, if desired.  
Separate directory names in the path using back-slashes. UNC-style file 
names are acceptable.

For certain file types (Excel, Access, etc.), you may need to append a 
modifier after the file name; see the discussion of file types at the end of this 
section for details.
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Attributes to transfer:

Enter the list of fields, or attributes, to be exported.  Enter either the 
attribute number or attribute name as defined in the file dictionary.  An 
asterisk (*) may be entered here to export all attributes (including the Item-
ID), from all selected items. A plus-sign (+) may be entered to export all 
attributes except the Item-ID.

Generate Header Record (<Y>/N):

Answer Y if you want the first record in the PC file to be a “header record”.  
The header record specifies the names of the fields of each data record in 
the file and may be used as column or field identifiers by certain Windows 
applications.  If an asterisk was entered for the attribute list, the header 
record will contain only an asterisk.

If asterisk was not entered for the attribute list, 

Explode MultiValue Fields (Y/<N>):

Answer Y to explode all multi-valued fields.  When multi-valued fields are 
exploded, a separate data record will be created for each multi-value, with 
any single-valued fields repeated for each multi-value. When multi-valued 
fields are not exploded, the value-mark characters remain in the data and 
appear as an accented ý.

When the transfer is complete, you may see a message like:

Converting file to Excel file format . . .

This indicates that the raw data has been downloaded and isbeing formatted 
in the native file format indicated by the file name you entered.
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Uploading Data Files From Your PC to the Host (Import)
Use the FTD utility to import data from a file on your PC to your 
MultiValue database. The PC file being imported should be a “database” 
such as a spreadsheet, delimited text file, html table, Access database or 
other database format recognized by AccuTerm.

To import data using FTD, enter FTD at the command prompt and follow 
the prompts.

(S)end, (R)eceive, (C)onfigure, (O)ptions, 
(H)elp or (E)xit ?

Answer R to receive, then select the file transfer protocol:

File transfer protocol: (A)SCII or (K)ermit ?

Kermit is recommended.

Enter source (DOS) file (path) name:

Enter the full PC file name including drive letter and directory, if desired.  
Separate directory names in the path using back-slashes. UNC-style file 
names are acceptable.

For certain file types, you may need to append a modifier after the file 
name; see the discussion of file types at the end of this section for details.

Use Header Record (<Y>/N):

Answer Y if you want the use the first record in the PC file as a “header 
record”.  The header record specifies the names (or numbers) of the 
attributes to be imported.  If the header record consists of a single asterisk, 
all fields (attributes) in each record are imported.  If you answer Y to this 
prompt, the next prompt will be “Enter target (Pick) file name”; other 
prompts will be bypassed.

Attributes to transfer:

Enter the list of attributes (fields) to be imported.  Enter either the attribute 
number or attribute name as defined in the file dictionary.  An asterisk may 
be entered here to import all attributes (entire record or item).  The 
attributes must be listed in the order that the fields appear in the source 
database or file.  If you do not want to import a particular field, you can 
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enter a dash ( - ) instead of an attribute name to skip that field.  Attribute 
definitions containing A or F correlatives cannot be specified.

Number of header records to skip:

Enter the number of records at the beginning of the PC file which are to be 
considered “header records”, which should to be ignored when importing 
the file.

Automatically generate target (Pick) IDs 
(Y/<N>):

Answer Y to generate item-IDs for each record.  If the item-ID is not 
specified in response to the “Attributes to transfer” prompt, you must
generate item-IDs.  The generated item-ID consists of a constant (possibly 
null) prefix, followed by a sequential number.  If item-IDs are not generated, 
the next two prompts will be skipped.

Auto ID Prefix:

Enter the constant item-ID prefix.  Null is acceptable if the generated item-
ID is simply a sequential number.

Auto ID Starting Number:

Enter the starting value for automatically generated item-IDs.

Enter target (Pick) file name:

Enter the name of the host file where the imported data is to be stored.

Before the transfer begins, you may see a message like:

Converting file from Excel format for upload

This indicates that the PC file data is being converted into a delimited 
ASCII format which can be imported to your MultiValue database prior to 
transfer to your host computer.



File Transfer 83

File Types for Import and Export
The default file format used by the FTD utility is ASCII delimited text.  In 
this format, records in the PC file are separated by a carriage return / line 
feed and fields are separated by tabs or commas.  If the field delimiter is a 
comma, then each field is enclosed in quotation marks.  Embedded 
quotation marks are duplicated.  This file format is easily imported by many 
Windows database and spreadsheet programs.

Certain file extensions are recognized by AccuTerm and are assumed to be a 
particular format. These extensions are:

.db2 dBase II

.dbf dBase III/IV

.htm, .html HTML table

.mdb Microsoft Access database

.sym Lotus Symphony

.wb1 Quattro

.wk1 Lotus v1-v2

.wks Lotus v3-v5

.xl, .xls Microsoft Excel

Import and Export from Excel
When accessing Excel workbook files, the FTD utility has the ability to 
reference explicit worksheets and ranges of cells. To use this feature, specify 
the Excel file name as: 

d:\path\file.xls!sheet!range

where d:\path\file.xls is the path of the Excel file, sheet is the 
worksheet name or tab number (sheet may be null to use the first 
worksheet in the workbook), range is the range of cells to access. Either a 
named range may be used or a cell location (e.g. A4) or cell range (e.g. 
B3:F42) may be specified.

When exporting data to Excel, the range identifies the upper-left cell of the 
target worksheet; the number of columns and rows is determined by the data 
being sent.

When importing data from Excel, the range specifies the entire block of data 
to be imported. To specify only the upper-left corner of the block (the 
number of columns and rows determined by the extent of the worksheet), 
follow the cell with a trailing colon (e.g. B3: ).
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When downloading to an Excel worksheet, the setting of the Overwrite 
option changes how AccuTerm stores the data.

No Overwrite: if the Excel file exists, and no worksheet has been specified, 
the transfer is aborted with an error. If a worksheet has been specified, and 
the worksheet exists, the transfer aborts. If the file does not exist, or if it 
exists but a new worksheet is specified, the transfer proceeds.

Overwrite: if both a worksheet and range are specified, cells in specified 
range are overwritten with new data. If only a worksheet is specified, the 
entire worksheet is replaced with new data. If only a range is specified, the 
cells in the specified range in the first worksheet are overwritten with new 
data. Otherwise, a new file or worksheet is created.

Merge: if the Excel file exists, and no worksheet is specified, a new 
worksheet is created. If a worksheet is specified, but a range is not, new 
cells are added to the end of the specified worksheet. If both worksheet and 
range are specified, new data replaces the specified range.

Import and Export from Microsoft Access
When accessing Microsoft Access tables, you must specify the table name in 
addition to the database file name.  You may also need to specify a 
connection string with your password to access the desired data source. To 
specify these items, enter the Access database file name as: 

d:\path\file.mdb!table!connection

where d:\path\file.mdb is the path of the Access database file, 
table is the table name in the database, connection is an optional 
string that may be necessary to connect to some data sources.

When downloading to an Access database, the setting of the Overwrite 
option changes how AccuTerm stores the data.

No Overwrite: if the Access database file exists, and the specified table 
exists, the transfer is aborted with an error. Otherwise the table is created in 
the specified file.

Overwrite: if the specified table exists in the database file, the table is 
cleared and new records are added to the table. If the table does not exist, it 
is created.
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Merge: if the specified table exists, new records are added to the table. 
Otherwise a new table is created.

FTD Options and Settings
Several configuration (permanent) and option (temporary) settings are 
available for the FTD utility. The permanent configuration settings are used 
as the default values for the temporary option settings.

FTD Configuration Settings
To change configuration (permanent) settings, enter C in response to the 
first prompt.  A list of configuration settings will be displayed:

Current parameter settings are:
1. Preserve file extension Yes
2. Overwrite existing item No
3. Large item treatment No action
4. Field delimiter Tab
5. Convert OEM char set to ANSI   No

Enter parameter number (1-5) to modify:

The setting for any of these items may be changed by entering the item 
number and pressing ENTER.

Preserve File Extension
This item is not used by the FTD utility.

Overwrite Existing Item
This option can be used to protect existing files and items from being 
overwritten. Select “Yes” to allow existing DOS files to be overwritten 
during downloads (host to PC), or existing items to be overwritten during 
uploads (PC to host). Select “No” to protect existing files (downloads) or 
items (uploads). Set to “Merge” to append or merge data into existing files 
during downloads.

Large Item Treatment
This item is not used by the FTD utility.
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Field Delimiter
The field delimiter (PC file) may be set to “Tab”, “Comma”, “CrLf” or any 
user-defined string. When you select “Comma” as the delimiter, AccuTerm 
encloses each field in quotation marks. “CrLf” can only be used for 
exporting data to the PC (when importing, the field andrecord delimiters
must be different). User-defined field delimiter is entered in hex, at the 
“Enter parameter…” prompt, as in 4=1A.

Convert OEM Char Set
If you enable OEM/ANSI character set conversion, the data is converted to 
the OEM character set before upload, and to the ANSI set after download. 
You should not enable this option unless you use international characters on 
your MultiValue host, and those characters are stored using the OEM 
character set (the set used by ADDS Viewpoint, Wyse, ANSI BBS andPC 
Monitor emulations).

FTD Option Settings
To change option settings, enter O in response to the first prompt.  A list of 
option settings will be displayed.  Note that the default value of the options 
is obtained from the configuration settings:

Current parameter settings are:
1. Preserve file extension Yes
2. Overwrite existing item No
3. Field delimiter Tab

The setting for any of these items may be changed by entering the item 
number and pressing ENTER.

An alternate way to set the value of an option setting is to answer the prompt 
with the item number, an equal sign, and the first letter of the value to which 
the parameter is to be set.  For example, to set the Field Delimiter to “Tab”, 
respond to “Enter parameter...” with 3=T.  This alternate method is 
useful in cases where the FTD utility is being “driven” by a PROC or by 
another program using the EXECUTE statement.

The meanings of these option settings are the same as the configuration 
settings described previously.



File Transfer 87

Transferring Data Between MultiValue Hosts
The FTPICK utility will transfer specified (or selected) items from one 
MultiValue computer to another.  This transfer can be done in one step if 
you have two AccuTerm sessions open, connected to each of the MultiValue 
host computers.  AccuTerm will also let you transfer data from one host to 
another using an intermediate file stored on your PC. This transfer requires 
two steps: transfer from first host to intermediate PC file, then transfer from 
the intermediate file to the other host.

Direct Host-to-Host (One Step) Transfer
The direct transfer requires two sessions running on AccuTerm - one session 
connected to the source host (sending machine), and one session connected 
to the target host (receiving machine). If you cannot run two sessions, you 
must use an intermediate PC file to store the data temporarily using the two 
step method (see next section). 

To use the FTPICK direct transfer method, activate the AccuTerm session 
connected to the target host, and start FTPICK. When prompted:

(S)end, (R)eceive, (C)onfigure, (O)ptions, 
(H)elp or (E)xit ?

Answer R to receive files, then select the direct mode:

Receive (D)irectly from PICK file or from 
(I)ntermediate DOS file ?

by answering D. A panel titled “AccuTerm Pick-to-Pick File Transfer” will 
be displayed on the target screen. You can cancel the Host-to-Host transfer 
at any time by pressing the ESC key while the target session is active. 

Next, activate the AccuTerm session connected to the source host, or 
sending machine, and start FTPICK. When prompted: 

(S)end, (R)eceive, (C)onfigure, (O)ptions, 
(H)elp or (E)xit ?

answer S to send files. Then enter the name of the source host file to be 
sent:
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Enter PICK source file name:

Enter the name of the source host file which contains the items to be sent.

Enter source (Pick) item list: 

Enter the item-IDs to be sent.  If you do not enter item-IDs, any previously 
selected (SELECT, GET-LIST, etc.) items will be transferred; if you enter 
an asterisk (*), all items in the file will be transferred.  To specify a saved 
list, enter an open parenthesis followed by the list name.  Separate item-IDs 
with blanks.

Send (D)irectly to PICK file or to 
(I)ntermediate DOS file ?

Answer D to send the file directly to the target machine.

Enter target PICK file name:

Enter the file name on the target machine into which the selected items will 
be written.

Once the target file name has been entered, the receiving session will be 
activated and the transfer progress will be displayed in the panel. When the 
transfer is complete, press the ESC key to terminate the receiving FTPICK 
program, or activate the sending session to send another file.

Host-to-Host transfer using Intermediate PC File (Two Step)
If you cannot open one session to each MultiValue host machine, or if you 
want to send the same file to several target machines, you can save the data 
in an intermediate PC file. The procedure is similar to the direct method 
described above, except that the send must be done first, and a PC file must 
be specified for both the send and receive steps. 

Step 1: Transferring From the Source Host to an Intermediate File
Open an AccuTerm session connected to the source machine, and start 
FTPICK. When prompted: 

(S)end, (R)eceive, (C)onfigure, (O)ptions, 
(H)elp or (E)xit ?

answer S to send files. Then enter the name of the source file to be sent: 
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Enter PICK source file name:

Enter the name of the source file which contains the items to be sent. 

Enter source (Pick) item list:

Enter the item-IDs to be sent.  If you do not enter item-IDs, any previously 
selected (SELECT, GET-LIST, etc.) items will be transferred; if you enter 
an asterisk (*), all items in the file will be transferred.  To specify a saved 
list, enter an open parenthesis followed by the list name.  Separate item-IDs 
with blanks.

Send (D)irectly to PICK file or to 
(I)ntermediate DOS file ?

Answer I to send the file to an intermediate PC file.

Enter intermediate DOS file name:

Enter the full PC file name of the intermediate file including drive letter and 
directory, if desired.  Separate directory names in a full path using back-
slashes.

Upon entering the PC file name, the selected items will be transferred to the 
specified PC file in a special format used by the FTPICK utility.

Step 2: Transferring From an Intermediate File to the Target Host
Open an AccuTerm session connected to the target machine, and start
FTPICK. When prompted: 

(S)end, (R)eceive, (C)onfigure, (O)ptions, 
(H)elp or (E)xit ?

answer R to receive files. Then enter the name of the intermediate PC file 
which contains the desired data: 

Receive (D)irectly from PICK file or from 
(I)ntermediate DOS file ?

Answer I to retrieve data from an intermediate file.

Enter intermediate DOS file name:
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Enter the full PC file name of the intermediate file including drive letter and 
directory, if desired.  Separate directory names in a full path using back-
slashes. 

Enter target PICK file name:

Enter the file name on the target machine into which the retrieved items will 
be written.

If the intermediate file is in the correct format, the items contained in the 
intermediate file will be transferred and stored into the target host file.

FTPICK Options and Settings
One configuration setting (permanent) and option setting (temporary) is 
available for the FTPICK utility.  To change configuration setting, enter C
in response to the first prompt.  A list of configuration settings will be 
displayed: 

Current parameter settings are: 
1. Overwrite existing item Yes

Enter parameter number (1-1) to modify:

The “overwrite existing file” setting may be changed by entering item 
number (1).

When using the direct mode, both the sender and receiver must have 
“Overwrite existing file” set to “Yes” in order for existing items to be 
overwritten. If either the sender or receiver has this settings set to “No”, 
existing items will not be overwritten.

If the receiver has “Overwrite” set to “No” and the sender has it set to 
“Yes”, the transfer will fail.

To change option setting, enter O in response to the first prompt.  A list of 
option settings will be displayed.  Note that the default value of the options 
is stored in the configuration settings:

Current parameter settings are:
1. Overwrite existing item Yes

Enter parameter number (1-1) to modify:
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An alternate way to set the value of a configuration or option setting is to 
answer the prompt with the parameter number, an equal sign, and the first 
letter of the value to which the parameter is to be set.  For example, to set 
the Overwrite option to “Yes”, respond to “Enter parameter...” with 1=Y.  
This alternate method is useful in cases where the FTPICK utility is being 
“driven” by a PROC or by another program using the EXECUTE statement. 
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Integrating File Transfer Functions into 
MultiValue Applications

You can integrate AccuTerm’s file transfer functions into your MultiValue 
application in two ways. First, you can use the command-line utilities from 
your BASIC programs or PROCs. To use the command-line utilities from a 
BASIC program, use DATA statements to feed answers to the prompts, 
followed by an EXECUTE statement with the desiredcommand-line utility 
program. For example, to use the FT utility to send a file from the 
MultiValue host to the PC, you might use the following BASIC code:

DATA 'S'
DATA 'K'
DATA 'BP'
DATA '(LST'
DATA 'C:\MVBP'
DATA ''
EXECUTE 'FT'

The same function in a PROC would look like:

PQ
HFT
STON
HS<
HK<
HBP<
H(LST<
H<
P

Callable subroutines are also provided for use in BASIC programs. The 
advantage of calling a subroutine over using EXECUTE (as shown above) is 
that the subroutine interface returns a variable indicating the transfer status 
(STAT). The following subroutines are available for use by your application 
programs:
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DOSSVC: this is a multi-function subroutine, combining send – execute –
receive functions. Data to send (or received data) is passed as an argument 
to the subroutine, along with an optional command line to execute between 
the send and receive steps.

FTS: simple file transfer. Data to be sent (or received data) is passed as a 
subroutine argument, along with the destination (or source) directory and 
file name, and a mode argument to specify transfer options such as protocol, 
direction and overwrite.

FTSEND: send file(s) from host to PC. Specify the source file and item list, 
remote directory and optional file list, and transfer options as subroutine 
arguments. Transfer status returned in STAT argument.This subroutine 
performs the same function as the FT command.

FTRECV: receive file(s) from PC to host. Specify the source directory and 
file list, destination host file and optional item list, and transfer options as 
subroutine arguments. Transfer status returned in STAT argument.This 
subroutine performs the same function as the FT command.

FTEXPORT: export data from host to PC. Specify the source file and item 
list, remote file, attribute list and transfer options as subroutine arguments. 
Transfer status returned in STAT argument. This subroutine performs the 
same function as the FTD command.

FTIMPORT: import data from PC to host. Specify the source file, 
destination host file, attribute list and transfer options as subroutine 
arguments. Transfer status returned in STAT argument.This subroutine 
performs the same function as the FTD command.

Calling interfaces are documented in the source code of each routine (FTBP
file).
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Standard (non-MultiValue) File Upload

Upload transfers a file (or files) from your computer to a remote machine.  
Uploads may use any of the supported protocols.  Usually, to perform a file 
upload, you would first start the receiving (download) program on the 
remote computer from normal terminal emulation mode.  Then after the 
remote receiving program has been started, select Tools Upload, select the 
appropriate protocol, select the file(s) to upload, then click the Upload 
button.

File Selection
Click the Browse button to select the file(s) to upload. If the currently 
selected protocol is Kermit, Ymodem, or Zmodem, you can select multiple 
files, otherwise select only a single file.

Protocol
Select the protocol you want to use to upload the selected file(s) by clicking 
the appropriate option button: ASCII, Kermit, Xmodem, Ymodem or 
Zmodem.  

The ASCII protocol by its nature has no error checking.  This protocol 
should only be used when there is a local, error free connection, and when 
the remote system does not support any of the other protocols.  The ASCII 
protocol only sends text files, and it is not a “batch” protocol - you can only 
send one file.  You can adjust the line termination to CR, LF or CR LF by 
selecting the desired option in the File Transfer tab of the Settings dialog 
box (Tools Settings menu).  You can also set the inter-line delay time in the 
same tab (this is the amount of time AccuTerm waits between lines when 
sending a file).

The Kermit protocol provides error detection and correction.  Kermit is a 
“batch” protocol, so you can send multiple files.  Kermit can send either 
text or binary files; text files are converted to the format required on the 
receiving machine.  Kermit is slower than X/Y/Zmodem, but is the most 
portable protocol.  It often succeeds when the other protocols fail.  Several 
options may be set in the File Transfer tab of the Settings dialog box.  
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These include the retry limit, timeout period, end of line character, eighth bit 
quoting, data compression and block check type (checksum or CRC).

Xmodem is a binary protocol which includes error checking.  Xmodem is 
not a “batch” protocol; you can only send one file using Xmodem, and you 
need to specify the file name to the receiving program.  Files transferred 
using Xmodem “grow” to the next multiple of 128 bytes.  The Xmodem 
protocol requires an 8-bit data path, and full 8-bit transparency (you cannot 
use Xon/Xoff handshaking when using Xmodem).  You can set the 
Xmodem timeout period in the File Transfer tab of the Settings dialog 
box.

Ymodem is a binary protocol which includes checksum or CRC error 
checking.  Ymodem is available in several “flavors”; the “flavor” used by 
AccuTerm is Ymodem-G (1K blocks, batch mode).  The Ymodem protocol 
requires an 8-bit data path, and full 8-bit transparency (you cannot use 
Xon/Xoff handshaking when using Ymodem).  You can set the Ymodem 
timeout period in the File Transfer tab of the Settings dialog box.

Zmodem is a sophisticated file transfer protocol which is popular on PCs 
and Unix based minicomputers.  Zmodem provides robust CRC error 
checking, several options for dealing with existing files and text file 
conversion.  If the receiving machine uses the “rz” program, AccuTerm will 
send the “rz” command before sending files, to automatically invoke the 
receiver’s Zmodem program.  The Zmodem protocol requires an 8-bit data 
path, but full 8-bit transparency is not normally required (you can use 
Xon/Xoff handshaking when using Zmodem).  You can set the Zmodem 
timeout period in the File Transfer tab of the Settings dialog box.

Mode
When the currently selected protocol is Kermit or Zmodem, you can select 
the transfer mode as text or binary.  When text mode is selected the line 
termination is adjusted to match that of the receiving machine.  When 
binary mode is selected, the files are transferred without alteration.  The 
ASCII protocol always transfers text files, and Xmodem and Ymodem
always transfer in binary mode.

Overwrite
When the Zmodem protocol is selected, the sender can select how to deal 
with existing files by selecting an Overwrite mode. Select never if you 
want to preserve all existing files.  Select always to overwrite existing files.  
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Append will append onto existing files.  The newer option replaces existing 
files only if the file being sent is newer than the existing file.  The update 
option overwrites existing files; non-existing files are not transferred.  Use 
the resume option for crash recovery after aborted transfers - if a file does 
not exist on the receiving machine, it is sent; if a file exists, but it is shorter 
than the file on the sending machine, the remainder of the file is sent; if a 
file exists, but it is the same length or longer, it is skipped.  Note: the 
resume option may only be used if the transfer mode is binary.
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Standard (non-MultiValue) File Download

Download transfers a file (or files) from a remote machine to your 
computer.  Downloads may use any of the supported protocols.  Usually, to 
perform a file download, you would start the sending program on the remote 
machine while in normal terminal emulation mode.  Then after the remote 
sending program has been started, select Tools Download, select the 
appropriate protocol, select the destination directory (and file name if using 
ASCII or Xmodem), then click the Download button.

Directory and File Selection
Click the Browse button to select the destination directory. If the currently 
selected protocol is ASCII or Xmodem, then you also need to specify a file 
name for the downloaded file.

Protocol
Select the protocol you want to use to download the selected file by clicking 
the appropriate option button: ASCII, Kermit, Xmodem, Ymodem or 
Zmodem.  For details about each of the protocols, see the discussion in the 
previous section.

Mode
When the protocol is set to ASCII, the mode is text; when it is set to 
Xmodem or Ymodem, the mode is binary.  When using Kermit, you can 
select either text or binary mode. The mode for Zmodem transfers is 
determined by the sender.

When text mode is selected lines are terminated with CR/LF. When binary 
mode is selected, the files are transferred without alteration.

Overwrite
Check this box to allow existing files to be overwritten.  Note: Kermit and 
Ymodem always overwrite. When Zmodem is selected, the sender controls 
the action to take if a file exists.
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DATA CAPTURE

AccuTerm is capable of capturing to a file any data received by the your 
computer, or any data which would normally be printed to the “slave” 
printer. To start data capture, select Tools from the main menu, then select 
the Capture option or click the button on the toolbar.  Select the 
capture file and options in the Begin Capture dialog.

Capture to File
Enter the capture file name in this field, or click the Browse button to select 
the folder and file.

Mode
Select New file only, Overwrite, Append, or Clipboard by clicking the 
appropriate option button.  If you select Overwrite or Append and the file 
does not exist, AccuTerm will create the file.  If you select New file only 
and the file does exist, a warning will be displayed.

Source
Select the data source to be captured as Received data or Printed data.  If 
Received data is selected, all data received by AccuTerm (except when a 
file transfer is occurring) will be captured to the specified file.  This 
includes all control characters.  If Printed data is selected, all data which 
would normally be printed to the slave printer port is captured to the 
selected file, and not printed.

Filter
Select the Text only (strip control codes) option if you want control 
characters filtered out of the captured data.
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Terminating Data Capture
If data capture is already in effect (as indicated in the status bar), selecting 
Tools Capture or clicking the button on the toolbar will display the 
End Capture dialog. Click the End Capture button to terminate the 
capture operation, or click the Continue button to resume capturing.
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MACRO RECORDER

AccuTerm 2K2 includes a powerful Macro Recorder which can be used to 
record a sequence of actions as a VBA macro. AccuTerm’s Macro Recorder 
records most menu or toolbar actions, changes to settings and preferences, 
and interaction with the host. The recorded macro can be edited, and you 
can attach a shortcut key to any recorded macro for instant execution of the 
recorded macro.

Recording a Macro
To start recording a new macro, select Record New Macro from the 
Macro sub-menu under the Tools menu. The Macro Recorder toolbar will 
be displayed near the lower-right corner of the AccuTerm window. When 
you are finished recording the macro, click the button on the Macro 
Recorder toolbar. You can temporarily suspend recording by clicking the 

button on the Macro Recorder toolbar. To resume recording, click the 

button.

When you are finished recording a macro, the Save Macro dialog will be 
displayed. Here you can give your recorded macro a name (up to 32 
characters: letters, numbers or underscore characters only, beginning with a 
letter), a short description (up to 32 characters) which is displayed in the 
Tools Macro Run Macro sub-menu, a detailed description and a shortcut 
key.

The recorded macro is saved in the AccuTerm Macros script file when you 
click the Save button. If you do not have a macro script file open yet, you 
will be prompted to select the file name for your macro file. Whenyou start 
AccuTerm, the macro script file (if it exists) is automatically loaded.

Macros are recorded as a sequence of Visual Basic for Applications (VBA) 
statements.

Running a Macro
To run a macro, select the desired macro from the Run Macro sub-menu of 
the Tools Macro menu. Alternatively, if the macro has a shortcut key 
assigned to it, simply press the shortcut key combination to run the macro.
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Editing a Macro
You can edit your recorded macros by selecting Edit from the Tools Macro
menu. The macro script will be displayed in the Macros tab (2) of the 
AccuTerm Script window. Macros are written using the Visual Basic for 
Applications (VBA) language. See the Scripting section of the 
Programmers Guide for more information on VBA scripts.
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WED EDITOR

AccuTerm 2K2 MultiValue Edition includes a handy Windows based 
program / data editor for use with your MultiValue host computer. wED is 
invoked just like the traditional ED verb, but opens the specified documents 
in a Windows full-screen editor. If you specify multiple item-IDs, each item 
is opened in its own window. The windows can be arranged, cascaded, or 
tiled. You can cut, copy and paste text between documents and other 
Windows applications.

When you edit BASIC programs using wED, wED highlights various 
BASIC syntax elements in different colors and text styles for easy 
recognition. You can even customize the color and text style used for 
highlighting, specify you own language keyword list and create a user-
defined keyword list. wED understands GOTO, GOSUB, CALL and INCLUDE
statements, and allows you to easily jump to the target of the statement.

Advanced editing features include block comment / uncomment, block 
indent / outdent, and a built-in BASIC code formatter. One-click compile is 
also included.

wED is installed when you install the MultiValue Host Programs (see File 
Transfer chapter). 

To customize wED, open the Tools menu and select General, Highlight or 
Tools. Complete online help is included.
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Using wED

The wED main window uses Windows “multiple document interface” to 
display one or more document windows. Each document can be accessed by 
clicking anywhere on the document window or by selecting the desired 
document from the Window menu. You can activate to the “next” document 
by pressing CTRL + TAB or CTRL + F6. The top area of the main window 
may contain a toolbar, and the bottom area may contain a status bar. These 
items may be selected from the View menu by checking Toolbar or Status 
Bar items.

To create a new document, choose New from the File menu or click the 
button on the toolbar.

To open an existing document, choose Open from the File menu or click the 
button on the toolbar. The Open dialog is customized for use with 

MultiValue systems. If you started wED from a TCL command prompt, or 
from the wED menu item or toolbar button in AccuTerm, you will be able to 
browse for the file and item you want to open. You can browse for files on 
either the host or local Windows file system.

When wED is open, you can use Windows drag-and-drop to open files from 
the local Windows file system. Just drag a text file from Windows Explorer 
and drop it on the wED menu bar. Similarly, you can create a shortcut to the 
main wED program (atwed32.exe) in your “Send To” folder to add wED as 
a “Send To” target in the Explorer context menu.

To save the current document, choose Save from the File menu or click the 
button on the toolbar. The Save dialog is customized for MultiValue 

systems and has the same browsing features as the Open dialog.

To save all open documents, choose Save All from the File menu or click 
the button on the toolbar.

To print the active document, choose Print from the File menu or click the 
button on the toolbar.
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Editing a Document using wED

The Document window contains the text of the document being edited. The 
text is displayed with a line number in the left margin, and may be 
highlighted by color and text style according to BASIC language syntax 
rules.

The document is edited using a free-form text editor, and fully supports 
standard Windows commands.

Typing Text
If any text is currently selected, typing text replaces the selection. If no text 
is selected, typing inserts at the current cursor position. Press ENTER to 
begin a new line. To insert a system delimiter (value-mark or sub-value-
mark) into the document, press CTRL + ] or click the button for a 

value-mark; press CTRL + \ or click the button for a sub-value-mark.

Cursor Movement
Move the cursor by pressing any cursor movement key  (UP, DOWN, LEFT, 
RIGHT, HOME, END, PAGEUP, PAGEDOWN). Holding the CTRL key when 
pressing another cursor key modifies the cursor key action as follows: CTRL

+ RIGHT moves forward one word, CTRL + LEFT moves backward one 
word, CTRL + HOME moves to the beginning of the document, CTRL + END

moves to the end of the document.

Selecting Text
You can select text either by using the mouse (click and drag), or from the 
keyboard. To select text from the keyboard, hold the SHIFT key while 
moving the cursor (UP, DOWN, LEFT, RIGHT, HOME, END, PAGEUP, 
PAGEDOWN). The SHIFT and CTRL keys can be used together; for example, 
CTRL + SHIFT + RIGHT selects the next word. Press CTRL + A to select the 
entire document.

Indenting Text
Press the TAB key to indent text, beginning at the current cursor position, to 
the next tab stop. If multiple lines are selected, pressing TAB or clicking the 

button indents all selected lines (at the beginning of the line); pressing 

SHIFT + TAB or clicking the button outdents all selected lines.
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Clipboard
To copy text to the clipboard, select the desired text and press CTRL + C or 
click the button. To copy to the clipboard and delete selected text (cut), 

press CTRL + X or click the button. To paste text from the clipboard, 

press CTRL + V or click the button.

Deleting Text
To delete text, select the desired text and press the DELETE key or click the 

button on the toolbar. If no text is selected, pressing the DELETE key 
erases the character to the right of the cursor. Press the BACKSPACE key to 
erase the character to the left of the cursor. Press CTRL + Y to delete the 
entire line that the cursor is on.

Searching
To search for text in the document, press CTRL + F or click the button 
on the toolbar. Enter the text you are looking for. Select the appropriate 
options (whole word, match case, direction) and click the Find Next button. 
To repeat the last search, press the F3 key or click the toolbar button. If 
you pass the end of the document and begin searching from the top, you will 
hear a beep, and a message will be displayed in the status bar (Find Again 
only).

Replacing Text
To search and replace text, press CTRL + H. Enter the text to search for and 
the replacement text. Select the appropriate options (whole word, match 
case) and click Find Next, Replace or Replace All.

Changing Case
To change the case of the selected text, select Toggle Case from the Tools
menu or click the button on the toolbar. Each time the Toggle Case
button is clicked, the case of the selected text is changed from its current 
form to Upper Case, Lower Case and Proper Case, in that order.

Commenting and Uncommenting Text
If you have a block of text selected, you can “comment out” the whole block 
by selecting Comment from the Edit menu or clicking the button on 
the toolbar. An asterisk (*) will be inserted at the beginning of each line in 
the selection. To "un comment" a block, select Uncomment from the Edit
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menu or click the button. The leading asterisk (*) of each line in the 
block will be deleted.

Undoing Changes
Press CTRL + Z or click the button to undo the last editing operation.

Redoing Changes
Select Redo from the Edit menu or click the button to redo the last 
operation which was un-done.

Goto
Click the button or select Goto from the Edit menu to open the Goto
dialog box. Enter a line number or choose a statement label to jump to.

Context Menu
If you click the right mouse button anywhere in the document window, a 
context (pop-up) menu is displayed. From the context menu, you can select 
Undo, Cut, Copy, Paste, Clear (delete), Select All, Find, Find Next, 
Replace, Open, Goto and Highlight. Some context menu choices may not 
be available depending on the location clicked and the state of the clipboard. 
For example, the Goto option is only enabled if you right-click on a label 
following a Gotoor Gosub statement, and Open is only available if you 
right-click on a program name after an Includeor Call statement.

Double-clicking on a statement label following a Gotoor Gosub statement 
works the same as selecting Goto from the context menu. Double-clicking 
on a program name following an Includeor Call statement works the same 
as selecting Open from the context menu.

Formatting BASIC Source Code
Select the Format option from the Tools menu or click the button on 
the toolbar to format the document as BASIC source code. The margin and 
indentation sizes are specified in the Tools tab of the wED settings, which 
can be selected by choosing Tools from the Options menu.

Compiling BASIC Code
Select the Compile option from the Tools menu or click the button to 
compile the document (program). The results of the compile operation are 
displayed in the Results window. If a compilation error occurred, double-
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click the error line in the Results window to position the cursor at the 
offending line in the source code. The compiler command and options are 
specified in the Tools tab of the wED settings, which can be selected by 
choosing Tools from the Options menu.

Syntax Highlighting
wED is able to parse BASIC language elements in the document and 
highlight various elements using a variety of colors and text styles. To 
enable or disable syntax highlighting, select Highlight from the View menu 
or from the context menu, or click the toolbar button. To specify 
custom colors, styles, language and user keywords, select Highlight from 
the Options menu.

Document Properties
You display the properties of the currently active document by selecting 
Document Properties from the File menu or pressing CTRL + L. Properties 
displayed include the document file and item name, current size, number of 
lines, selection size, and number of lines selected.

Results Window
You can open the Results window by selecting Results from the View
menu. This window displays the results of the last compile operation. 
Double-clicking on an error line number will position the cursor onthat line 
(in the current document).
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APPENDIX A

ASCII Codes

ASCII Decimal Hex ASCII Decimal Hex
NUL 0 00 SPACE 32 20
SOH 1 01 ! 33 21
STX 2 02 " 34 22
ETX 3 03 # 35 23
EOT 4 04 $ 36 24
ENQ 5 05 % 37 25
ACK 6 06 & 38 26
BEL 7 07 ' 39 27
BS 8 08 ( 40 28
HT 9 09 ) 41 29
LF 10 0A * 42 2A
VT 11 0B + 43 2B
FF 12 0C , 44 2C
CR 13 0D - 45 2D
SO 14 0E . 46 2E
SI 15 0F / 47 2F
DLE 16 10 0 48 30
DC1 17 11 1 49 31
DC2 18 12 2 50 32
DC3 19 13 3 51 33
DC4 20 14 4 52 34
NAK 21 15 5 53 35
SYN 22 16 6 54 36
ETB 23 17 7 55 37
CAN 24 18 8 56 38
EM 25 19 9 57 39
SUB 26 1A : 58 3A
ESC 27 1B ; 59 3B
FS 28 1C < 60 3C
GS 29 1D = 61 3D
RS 30 1E > 62 3E
US 31 1F ? 63 3F
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ASCII Codes (continued)

@ 64 40 ` 96 60
A 65 41 a 97 61
B 66 42 b 98 62
C 67 43 c 99 63
D 68 44 d 100 64
E 69 45 e 101 65
F 70 46 f 102 66
G 71 47 g 103 67
H 72 48 h 104 68
I 73 49 i 105 69
J 74 4A j 106 6A
K 75 4B k 107 6B
L 76 4C l 108 6C
M 77 4D m 109 6D
N 78 4E n 110 6E
O 79 4F o 111 6F
P 80 50 p 112 70
Q 81 51 q 113 71
R 82 52 r 114 72
S 83 53 s 115 73
T 84 54 t 116 74
U 85 55 u 117 75
V 86 56 v 118 76
W 87 57 w 119 77
X 88 58 x 120 78
Y 89 59 y 121 79
Z 90 5A z 122 7A
[ 91 5B { 123 7B
\ 92 5C | 124 7C
] 93 5D } 125 7D
^ 94 5E ~ 126 7E
_ 95 5F DEL 127 7F
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ASCII Codes (continued)

128 80 160 A0
129 81 ¡ 161 A1
130 82 ¢ 162 A2
131 83 £ 163 A3

IND 132 84 ¤ 164 A4
NEL 133 85 ¥ 165 A5
SSA 134 86 ¦ 166 A6
ESA 135 87 § 167 A7
HTS 136 88 ¨ 168 A8
HTJ 137 89 © 169 A9
VTS 138 8A ª 170 AA
PLD 139 8B « 171 AB
PLU 140 8C ¬ 172 AC
RI 141 8D 173 AD
SS2 142 8E ® 174 AE
SS3 143 8F ¯ 175 AF
DCS 144 90 ° 176 B0
PU1 145 91 ± 177 B1
PU2 146 92 ² 178 B2
STS 147 93 ³ 179 B3
CCH 148 94 ´ 180 B4
MW 149 95 µ 181 B5
SPA 150 96 ¶ 182 B6
EPA 151 97 · 183 B7

152 98 ¸ 184 B8
153 99 ¹ 185 B9
154 9A º 186 BA

CSI 155 9B » 187 BB
ST 156 9C ¼ 188 BC
OSC 157 9D ½ 189 BD
PM 158 9E ¾ 190 BE
APC 159 9F ¿ 191 BF
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ASCII Codes (continued)

À 192 C0 à 224 E0
Á 193 C1 á 225 E1
Â 194 C2 â 226 E2
Ã 195 C3 ã 227 E3
Ä 196 C4 ä 228 E4
Å 197 C5 å 229 E5
Æ 198 C6 æ 230 E6
Ç 199 C7 ç 231 E7
È 200 C8 è 232 E8
É 201 C9 é 233 E9
Ê 202 CA ê 234 EA
Ë 203 CB ë 235 EB
Ì 204 CC ì 236 EC
Í 205 CD í 237 ED
Î 206 CE î 238 EE
Ï 207 CF ï 239 EF
Ð 208 D0 ð 240 F0
Ñ 209 D1 ñ 241 F1
Ò 210 D2 ò 242 F2
Ó 211 D3 ó 243 F3
Ô 212 D4 ô 244 F4
Õ 213 D5 õ 245 F5
Ö 214 D6 ö 246 F6
× 215 D7 ÷ 247 F7
Ø 216 D8 ø 248 F8
Ù 217 D9 ù 249 F9
Ú 218 DA ú 250 FA
Û 219 DB û 251 FB
Ü 220 DC ü 252 FC
Ý 221 DD ý 253 FD
Þ 222 DE þ 254 FE
ß 223 DF ÿ 255 FF
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Index

Access, 87
ActiveX, 1
AES, 37
ANSI Options, 46
Answerback, 50
ASCII, 98
ASCII Codes, 113
ASCII Settings, 64
Auto Answer, 31
Auto close, 28
Auto Close, 25
Auto Dialer, 69
Auto print, 46
auxiliary port, 103
Baud Rate, 29
Beep, 67
Bell sound, 67
binary mode, 99, 101
Blinking, 49
Blowfish, 37
CapsLock, 59
Capture Source, 103
checksum, 65
color, 53
Colors

border style, 56
line drawing, 56
protected attribute, 56
schemes, 54
visual styles, 55

Communication Errors, 28
Communications Device, 27
Communications Port, 29
Connection Method, 27
Connection Settings

Serial Port, 29
Connection Type, 27
Connection Wizard, 10

control codes, 1
CRC, 65
Cursor shape, 49
Data Bits, 29
data capture

starting, 103
Data Capture, 103
data compression, 65
Database files, 83
dBase, 87
Default capture directory, 24
Default download directory, 24, 

65
default phone book, 24
default transfer mode, 65
Default upload directory, 24, 65
Delimited files, 83
DES, 37
Device, 27
dial, 69
Dialing Options, 31
Download, 71, 101
DSA, 39
DTR/DSR, 30
Duplex, 27
Edit Menu, 13
Editing macros, 17
eighth bit

quoting, 65
stripping, 27

email, 63
Encryption, 3
error checking

checksum, 65
CRC, 65

error detection, 98
escape sequences, 1
Euro, 52



114 Index

evaluation version, 9
Excel, 83, 85, 87
existing files, 100, 101
Exporting files, 83
extended mode, 47
Extended Mode, 49
fax, 63
File Menu, 12
File Selection, 98, 101
File Transfer, 71
file transfer protocol

ASCII, 71
Kermit, 71
Xmodem, 71
Ymodem, 71
Zmodem, 71

file transfer protocol options, 64
File transfer, Direct Pick-to-Pick 

transfer, 91
File transfer, DOS file to Pick 

file, 85
File transfer, Download, 78
File transfer, File formats, 87
File transfer, FT options, 81
File transfer, FTD options, 89
File transfer, FTD utility, 83
File transfer, FTPICK options, 94
File transfer, FTPICK utility, 91
File transfer, Importing data, 85
File transfer, Indirect Pick-to-

Pick transfer, 92
fingerprint, 41
Font, 51

character set, 52
Euro character, 52
legible, 52
scaling, 51
size, 51
style, 51

function key programming, 58
garbled data, 32
Graphic Mode

enabling, 49

Handshake, 29
Hangup, 69
Hardware Requirements, 4
Help, 19
Help Menu, 19
History, 20
History buffer, 48
History Rows, 48
host integration, 1
Host programs

installation, 72
Host Terminal Type, 45
HTML table, 87
Icon, 47
Importing a key, 41
Importing files, 85
Installation, 7
inter-line delay, 98
Internet Explorer, 3
Kermit, 76, 98
Kermit Settings, 65
Keyboard

key caption, 59
key code, 58

Keyboard Commands, 20
layout file, 11
line end

ASCII, 64
Line Wrap, 49
Lotus, 87
Macro Recorder, 105
Macros, 17
MDI, 1, 10
Modem, 31
Mouse

enabling, 49
mouse wheel, 48
Multinational character set, 46
Multiple Document Interface, 1, 

10
MultiValue host programs

installation, 72
MultiValue Host Programs
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activating other accounts, 75
MultiValue server, 17
Network Installation, 9
normal mode, 47
OLE, 1
OpenSSH, 39
Parity, 29
Paste, 64
Paste Options

line end, 67
paste end, 67

PCL, 63
PDF files, 63
Personal Edition, 10
Phone book, 24
phone book file, 24
Phone directory, 69
phone directory file, 70
Pick host programs

installation, 72
Pick Host Programs

activating other accounts, 75
PicLan, 42

Host, 42
Timeout, 42

Port, 29
Print Adapters, 63
Printer

job close timeout, 63
Printer Selection, 62
PrintWizard, 63
Programmers Guide, 1
Protocol, 98, 101
Recording a macro, 17
Reset Menu, 18
RSA, 39
RTS/CTS, 30
Running a macro, 17
Screen Print, 62
Screen Sizes, 47
scripting, 1
Scripting language, 2
scroll bars, 47

Scrollback, 20, 48
Secure Shell, 3

Authentication, 37
Break character, 37
Host, 36
IP address, 36
Keepalive, 38
Key, 37
Key Management, 39
Options, 37
Outbound coalescing, 38
Port, 36
Preferred Cipher, 37
SSH version, 37
Terminal Type, 45
Timeout, 36
U2 Device Licensing, 38

selection, 13
serial number, 19
Session Title, 47
Settings

Colors, 53
Connection, 27
File Transfer, 64
Font, 51
General, 24
Keyboard, 57
Miscellaneous, 67
Printer, 61
Screen, 47
Terminal Type, 43

Shortcut, 11
Shortcut keys, 60
Single instance, 25
slave printer, 103
Slave Printer, 62
Software Handshake, 30
Software Requirements, 4
Spreadsheet files, 83
ssh, 36
start capturing, 103
Status Line, 45
Stop Bits, 29
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Strip Eighth Bit, 27
System Requirements, 4
TAPI, 31
TCL Rules, 17
TCP/IP, 33, 36
TCP/IP hosts file, 24
Telnet, 33

Alternate break option, 34
Binary option, 34
Bypass option, 34
Connect Timeout, 33
Echo option, 34
Host Name, 33
Host Type, 33
IP address, 33
Keepalive, 35
Options, 34
Outbound coalescing, 35
Port, 33
Terminal Type, 45
U2 Device Licensing, 35

Terminal Emulation, 43

text mode, 99, 101
Timeout, X/Y/Zmodem, 64
Title format, 24
Tools Menu, 15
Underline, 49
Upload, 71
VBA, 2, 105
Video Pages, 48
View Menu, 14
visual attributes, 53
visual styles, 55
wED Editor, 107
wheel mouse, 48
Window Menu, 18
Wrapping, 49
Xmodem, 98
Xon/Xoff, 30
Ymodem, 98
Zmodem, 98

crash recovery, 100
Zmodem, automatic download, 
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